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About this information product

...............................................................................................................................................................................................................................................................

Purpose This preface provides an overview of this information product, which
is the Navis™ Provisioning Manager - Multi-Regional Provisioning
(MRP) Administration Guide.

The purpose of this Administration Guide is to explain to users how
to administer the Navis™ Optical Provisioning Manager -
Multi-Regional Provisioning (MRP) Release 1.1.

Reason for reissue Issue 1 of this Administration Guide is a new document that supports
the supports the Navis™ Optical PM - MRP, Release 1.1.

Safety labels This document does not use safety labels.

Intended audience This information product is written primarily for operations personnel
who administer Navis™ Optical PM - MRP. It may be used by anyone
desiring specific information about the features, applications and
operations of Navis™ Optical PM - MRP.

....................................................................................................................................................................................................................................
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How to use this
information product

This document contains:

• task information, which includes administration tasks (that is,
step-by-step instructions).

• conceptual information, which is specific data related to the
tasks.

Both types of information is presented within the chapters of this
Administration Guide.

Chapter descriptions

The following table describes the information in each chapter of this
Administration Guide.

Section Title Description

Preface About this information
product

Explains this document’s
purpose, its intended
audience, and how to use
the document.

Chapter 1 Chapter 1, “Administration
overview”

Provides an overview of
the administration process.

Chapter 2 Chapter 2, “Platform
Administration”

Contains tasks used to
power on and power down
HP-UX® and Windows®
servers and workstations
and printer set-up tasks.

Chapter 3 Chapter 3, “Users and User
Profiles”

Explains user and user
profile concepts, how to
create User IDs and assign
user privileges. Defines
how to restrict system
access.

Chapter 4 Chapter 4, “System
administration”

Explains how to start and
stop the system, set
preferences, restart the
database and how to
perform other system
administration tasks.

Chapter 5 Chapter 5, “Provisioning
Administration”

Contains tasks on
managing aggregates and
user-defined submaps.

Administration Guide About this information product
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Section Title Description

Chapter 6 Chapter 6, “Environment
provisioning”

Contains Off-Line tool
tasks used to set up the
Navis™ Optical PM - MRP
environment by
provisioning links and
merging circuits. It also
contains a task used to
extract inter-domain data
from the IDLPM
application and load it into
Navis™ Optical PM - MRP.

Chapter 7 Chapter 7, “Network
communication
management”

Includes instructions for
synchronizing the Navis™

Optical PM - MRP
database with the DMS
database.

Chapter 8 Chapter 8, “System
maintenance”

Provides instructions on
how to perform backups,
recover from system
failures, and monitor
space.

Chapter 9 Chapter 9, “Trouble
clearing”

Contains troubleshooting
tasks.

Chapter
10

Chapter 10, “ Navis™

Optical PM - MRP
Software Release, Version,
and Patch Information”

Contains information on
how to display Navis™

Optical PM - MRP
software release, load ID,
version number, and patch
information.

Appendix
A

Appendix A, “Navis™

Optical PM - MRP File
systems”

Lists the Navis™ Optical
PM - MRP file systems.

Appendix
B

Appendix B, “Navis™

Optical PM - MRP
Off-Line tools”

Provides information on
using the Navis™ Optical
PM - MRP Add a DMS,
Data Population, and
Change Network Element
Off-Line tools.

Administration Guide About this information product
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Section Title Description

Appendix
C

Appendix C, “Common
Unix® Commands”

Contains information on
common UNIX®
commands.

Index Index Enables the user to find
information quickly on
specific topics.

Conventions used This Administration Guide relies on the following typographical
conventions to distinguish between computer input and output.

• When describing the Navis™ Optical PM - MRP software, fields
in windows and field entries are identified with this font.

• When describing the UNIX® environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX® environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This Administration Guide is part of a set of documents that supports
the Navis™ Optical PM - MRP.

List of documents

The document set that supports Navis™ Optical PM - MRPcomprises:

1. Navis™ Optical PM - MRP Administration Guide, (365-309-803)
- provides instructions on how to administer Navis™ Optical PM
- MRP and the network. This document includes tasks and
conceptual information.

2. Navis™ Optical PM - MRP Provisioning Guide, (365-309-804) -
provides instructions on how to use Navis™ Optical PM - MRP
to provision and manage a network. This document includes tasks
and conceptual information.

Glossary

The Navis™ Optical NMS Administration Guide contains a glossary
that will be helpful to users of Navis™ Optical PM - MRP.

Administration Guide About this information product
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On-line documentation

On-line documentation for Navis™ Optical PM - MRP is provided in
two formats:

1. An on-line version, in HTML format, of this document set is
provided as part of the Navis™ Optical PM - MRP software.

2. An on-line version, in HTML format, of this document set is
available on CD-ROM. The CD-ROM, which is titled Navis™

Optical PM - MRP User Documentation CD-ROM,
(365-309-805) - includes the full set of documents listed
previously.

Screen help

The Navis™ Optical PM - MRP software includes screen help for each
form, which describes the purpose of the form, each field, and each
button.

Additional documents

The document set that supports Navis™ Optical Network Management
System (NMS) also provides valuable information for the users of
Navis™ Optical PM - MRP. The document set that supports Navis™

Optical NMS includes:

1. Navis™ Optical NMS Getting Started Guide, (365-309-260) -
provides information needed when you are learning how to use
the Navis™ Optical NMS software. It describes how to start and
stop Navis™ Optical NMS, how to use the software, and how to
interpret the graphical user interface. This document includes
tasks and conceptual information.

2. Navis™ Optical NMS Applications and Planning Guide,
(365-309-261) - describes the Navis™ Optical NMS features and
applications, provides a product description and the hardware
platforms for the product, and describes system planning and
engineering, ordering, and product support. This document
contains conceptual information only.

3. Navis™ Optical NMS Provisioning Guide, (365-309-262) -
instructs users on how to use Navis™ Optical NMS to provision
and manage a network. This document includes tasks and
conceptual information.

Administration Guide About this information product
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4. Navis™ Optical NMS Maintenance Guide, (365-309-263) -
instructs users on how to maintain Navis™ Optical NMS and the
network. This document includes tasks and conceptual
information.

5. Navis™ Optical NMS Administration Guide, (365-309-264) -
instructs users on how to administer Navis™ Optical NMS and
the network. This document includes tasks and conceptual
information.

6. Navis™ Optical NMS User Documentation CD-ROM,
(365-309-265) - the CD-ROM version of the Navis™ Optical
NMS document set.

How to comment To comment on this information product, go to the Online Comment
Form (http://www.lucent-info.com/comments) or email your comments
to the Comments Hotline (ctiphotline@lucent.com).

How to order To order Navis™ Optical PM - MRP information products, contact
your Lucent Technologies customer team representative or contact
Lucent Technologies at:

• From the United States, call 888-LUCENT8 (888-582-3688),
prompt 1.

• From Canada, call 317-322-6615.

• From Europe, the Middle East, Africa, Asia, the Pacific, China,
the Caribbean, and Latin America, call 317-322-6416.

Administration Guide About this information product
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1 Administration overview

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the Navis™ Optical Provisioning
Manager - Multi-Regional Provisioning (MRP) administration process.

Platform administration
and Navis™ Optical PM -

MRP administration

This document contains the administrative operations for Navis™

Optical PM - MRP.

It covers the following administration categories:

• Platform Administration, which contains critical platform setup
tasks that are performed outside of the Navis™ Optical PM -
MRP application. This category includes tasks for powering on or
powering off the HP-UX server, HP-UX workstation or Windows
workstation, adding users, and configuring printers.

• Navis™ Optical PM - MRP Administration, which includes tasks
and concepts specific to this application.

Contents
What is administration? 1-2

Who performs administration tasks? 1-3

Supported hardware configuration 1-4

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies 1 - 1



What is administration?
....................................................................................................................................................................................................................................

Introduction Navis™ Optical PM - MRP administration involves providing the
following types of support for Navis™ Optical PM - MRP and the
network:

• Platform administration

• User security administration

• System administration

• Environment provisioning

• System maintenance

• Network communication management

• Trouble clearing

Platform administration Platform support includes tasks associated with HP-UX servers,
HP-UX workstations, and Windows workstations.

User security
administration

User security administration includes tasks associated with adding
and deleting Navis™ Optical PM - MRP user IDs and profiles.

System administration System administration includes tasks associated with administering
the Navis™ Optical PM - MRP application.

Environment provisioning Environment provisioning includes tasks used to provision links and
merge circuits.

System maintenance System maintenance includes maintenance tasks, such as backing up
and recovering from system failures, and monitoring space.

Network communication
management

Network communication management involves synchronizing the
Navis™ Optical PM - MRP database with the Domain Management
System (DMS) database.

Trouble clearing Trouble clearing includes tasks associated with enabling trace and
viewing log and console.log files.

Administration overview

....................................................................................................................................................................................................................................
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Who performs administration tasks?
....................................................................................................................................................................................................................................

Introduction Administrative tasks are performed by users who are designated as
system administrators of specific types.

System administrator user
types

The following system administrator user types are supported by
Navis™ Optical PM - MRP:

• Navis™ Optical PM - MRP System Administrator, which is the
dacscan user with privileges to start or stop Navis™ Optical PM
- MRP.

• Navis™ Optical PM - MRP Administrator, which is an sa user
allowed to create other Navis™ Optical PM - MRP application
users.

In addition to these system administrator user types, there are also
hardware administrators for UNIX® and Windows® systems known
as OS (Operating System) Superusers. The OS superuser has ultimate
power over UNIX® or Windows hardware and are root or
Administrator respectively.

For a description of Navis™ Optical PM - MRP user types, see “ User
types and user profiles” (3-4) in Chapter 3, “Users and User Profiles”.

Functions Users with system administrator privileges are able to perform tasks
that enable them to:

• Provide security management, provisioning, and system support
for the Navis™ Optical PM - MRP host and the Network Map

• Control the appearance of the Network Map

Administration overview
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Supported hardware configuration
....................................................................................................................................................................................................................................

Hardware configuration The configuration supported by Navis™ Optical PM - MRP consists of
a single server with or without mirrored disks. A mirrored disk
configuration eliminates the need for a second processor as a backup.
The application and database that reside on separate disks are
mirrored onto a second set of disks. Information that is written to disk
is reflected simultaneously onto the mirrored counterpart. It is
recommended that the mirroring status is checked regularly to ensure
that all mirrored information is synchronized with the primary
information.

The tasks in this guide apply to the Navis™ Optical PM -
MRP-supported configuration only.

For details on Navis™ Optical PM - MRP hardware configuration,
refer to the Navis™ Optical PM - MRP Provisioning Guide and the
Navis™ Optical NMS Applications and Planning Guide.

Optional UPS Customers may choose to provide an Uniterruptible Power Supply
(UPS) for additional high availability protection. UPS protects the
main servers and their essential peripherals from downtime resulting
from power failures. In the case of long power losses, the UPS
enables the system to shut down gracefully. The amount of time
power is supplied is dependent on the type of UPS selected by the
customer.

The UPS provides a configurable file that contains two timers used in
the shutdown. When the Navis™ Optical PM - MRP application
receives notification of a loss of AC power, the application runs a
shutdown script that results in a graceful shutdown of the application
within the time limit of the timers. These two timers are:

• shutdown_delay_mins: the number of minutes from the time
UPS switches to internal battery power until the UPS monitor
initiates a shutdown. The default value for this parameter is one
minute.

• shutdown_timeout_mins: the number of minutes the shutdown
operation is monitored before a reboot is initiated with the halt
option. The default value for this parameter is five minutes.

These timers are tunable at the time of installation and can be
changed after installation; however, under normal conditions they
should not be changed.

Administration overview
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2 Platform Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains information on how to:

• power on and off HP-UX servers, HP-UX workstations, and
Windows® workstations

• add printers

Contents
Section I: Power on the HP-UX server, HP-UX
workstation and Windows® workstation

2-3

Power on an HP-UX server 2-4

Power on an HP-UX workstation 2-5

Power on a Windows® workstation 2-6

Section II: Power down the HP-UX server,
HP-UX workstation and Windows® workstation

2-7

Power down an HP-UX server 2-8

Power down an HP-UX workstation 2-10

Power down a Windows® workstation 2-11

Section III: Printer Administration 2-12

Install a networked printer on a Navis™ Optical PM
- MRP server

2-13
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Add a network printer 2-15

Add a local serial printer 2-16
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Section I: Power on the HP-UX server, HP-UX workstation and
Windows® workstation

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to power on an HP-UX server, an HP-UX
workstation, and a Windows® workstation.

Contents
Power on an HP-UX server 2-4

Power on an HP-UX workstation 2-5

Power on a Windows® workstation 2-6
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Power on an HP-UX server
....................................................................................................................................................................................................................................

Purpose Use the following task to power on an HP-UX server.

Important! When the system is powered on, it does not
automatically start the Navis™ Optical PM - MRP application.

Task Complete the steps below to power on the HP-UX server.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the HP-UX server (press the power switch or turn the key,
as appropriate).

Result:

The HP-UX server runs a sequence of diagnostics and then
boots into multi-user mode. The server is ready when the
Console Login prompt is displayed on the controlling terminal.
Its initial run-level setting is 3.

Section I: Power on the HP-UX server,
HP-UX workstation and Windows®
workstation

Platform Administration
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Power on an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use this task to power on an HP-UX workstation.

Task Complete the steps below to power on an HP-UX workstation.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the workstation (press the power switch or turn the key, as
appropriate).

Result:

The workstation runs a sequence of diagnostics and then boots
to the X-Windows system. The workstation is ready when the
Common Desktop Environment (CDE) login dialog box is
displayed.

Section I: Power on the HP-UX server,
HP-UX workstation and Windows®
workstation
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Power on a Windows® workstation
....................................................................................................................................................................................................................................

Purpose Use this task to power on a Windows® workstation.

Task Complete the steps below to power on a Windows® workstation.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the workstation (press the power switch or turn the key, as
appropriate).

Result:

The workstation runs a sequence of diagnostics. The workstation
is ready when the Windows® login dialog box is displayed.

Section I: Power on the HP-UX server,
HP-UX workstation and Windows®
workstation
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Section II: Power down the HP-UX server, HP-UX workstation
and Windows® workstation

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to power down an HP-UX server, an
HP-UX workstation, and a Windows® workstation.

The Navis™ Optical PM - MRP application must be shut down before
the server is powered off. For details on starting and stopping the
Navis™ Optical PM - MRP server and user interface applications, refer
to “Section I: Start and Stop the Navis™ Optical PM - MRP server
application” (4-3) and “Section II: Start and Exit the Navis™ Optical
PM - MRP User Interface application” (4-8) in Chapter 4, “System
administration”.

Contents
Power down an HP-UX server 2-8

Power down an HP-UX workstation 2-10

Power down a Windows® workstation 2-11
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Power down an HP-UX server
....................................................................................................................................................................................................................................

Purpose Use this task to power down an HP-UX server.

Before you begin Before you begin this task, be sure to:

• follow the step below to shut down the Navis™ Optical PM -
MRP application.

• use local procedures to inform users that the application will be
shut down.

Task Complete the steps below to power down an HP-UX server.
............................................................................................................................................................

1 On the control terminal, log in as root.

............................................................................................................................................................

2 Shut down the Navis™ Optical PM - MRP application. See “Stop the
Navis™ Optical PM - MRP server application” (4-6) in Chapter 4,
“System administration”.

............................................................................................................................................................

3 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

4 At the prompt, type shutdown -h -y 0

Important! The 0 value in the command line shutdown -h -y 0
causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to be waited before the shutdown is to
commence.

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system

Section II: Power down the HP-UX server,
HP-UX workstation and Windows®
workstation

Platform Administration
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UNLESS ’wait for UPS to turn off power’ message was
printed above

............................................................................................................................................................

5 Switch off the HP-UX server (press the power switch or turn the key,
as appropriate).

Result:

The HP-UX server is powered off.

............................................................................................................................................................

6 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.

Section II: Power down the HP-UX server,
HP-UX workstation and Windows®
workstation
Power down an HP-UX server
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Power down an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use the following task to power down an HP-UX workstation.

Task Complete the steps below to power down an HP-UX workstation.
............................................................................................................................................................

1 Log in to the workstation as root.

............................................................................................................................................................

2 At the prompt, type cd /

............................................................................................................................................................

3 At the prompt, type shutdown -h -y 0

Important! The 0 value in the command line shutdown -h -y 0
causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to be waited before the shutdown is to
commence.

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

4 Switch off the workstation (press the power switch or turn the key, as
appropriate).

Result:

The workstation is powered off.

Section II: Power down the HP-UX server,
HP-UX workstation and Windows®
workstation

Platform Administration
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Power down a Windows® workstation
....................................................................................................................................................................................................................................

Purpose Use this task to power down a Windows® workstation.

Task Complete the steps below to power down a Windows®
workstation.
............................................................................................................................................................

1 Log in to the workstation as Administrator.

............................................................................................................................................................

2 Select Start > Shut Down.

Result:

The Shut Down Windows® dialog box is displayed.

............................................................................................................................................................

3 Select the Shut Down... radio button and select Yes.

Result:

The Windows® workstation powers down.

............................................................................................................................................................

4 Switch off the workstation (press the power switch or turn the key, as
appropriate).

Result:

The workstation is powered off.

Section II: Power down the HP-UX server,
HP-UX workstation and Windows®
workstation

Platform Administration
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Section III: Printer Administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add a printer and set up the Common
Desktop Environment (CDE) icon. Procedures for installing a
networked printer on a server and for adding a network and a local
serial printer are provided.

Contents
Install a networked printer on a Navis™ Optical PM
- MRP server

2-13

Add a network printer 2-15

Add a local serial printer 2-16

Platform Administration
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Install a networked printer on a Navis™ Optical PM - MRP
server
....................................................................................................................................................................................................................................

Purpose Use this task to install a networked printer on a Navis™ Optical PM -
MRP server.

Before you begin Before you begin this task, collect the following information about the
network printer by printing the test/configuration page from the
printer.

• Printer name

• IP Address

• LAN Hardware Address

• Name or IP address of the server providing spooler facilities

Task Complete the steps below to add a networked printer on a Navis™

Optical PM - MRP server.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Access the test menu on your printer and run a self test.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

3 Press On Line.

............................................................................................................................................................

4 From the system console, log into the server as root.

............................................................................................................................................................

5 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts are displayed.

Section III: Printer Administration Platform Administration
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............................................................................................................................................................

6 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section III: Printer Administration
Install a networked printer on a Navis™

Optical PM - MRP server

Platform Administration
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Add a network printer
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a network printer.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

• IP address

The network printer must be connected to Ethernet.

Task Complete the steps below to add a network printer.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Access the test menu on your printer and run a self test.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

3 Press On Line.

............................................................................................................................................................

4 Using the system console, log into the server as root.

............................................................................................................................................................

5 At the # prompt, enter ksh /install/prtinstall

............................................................................................................................................................

6 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section III: Printer Administration Platform Administration
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Add a local serial printer
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a local serial printer.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

The local serial printer must be connected to the asynchronous
multiplexer board.

Task Complete the steps below to add a local serial printer to your
server.
............................................................................................................................................................

1 Using the system console, log into the server as root.

............................................................................................................................................................

2 At the # prompt, enter ksh /install/prtinstall

............................................................................................................................................................

3 Answer the questions as appropriate.

Result:

The local serial printer is added.

Section III: Printer Administration Platform Administration
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3 Users and User Profiles

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides the conceptual information needed to
comprehend the administration of users and user profiles in the
Navis™ Optical PM - MRP. It also includes tasks used to add users,
assign privileges, and restrict access to the Navis™ Optical PM - MRP
application.

Contents
Section I: User and User Profile Concepts 3-3

User and User Profile Concepts 3-4

Section II: User Types, User IDs, and Privileges 3-5

Create a User ID using the SAM GUI-based
program

3-6

Create a User ID with the SAM terminal-based
program

3-9

Assign User privileges on a Windows® PC 3-13

Assign User privileges on a Windows® 2000 PC 3-15

Assign System Administrator (SA) privileges on a
Windows® PC

3-17

Section III: Navis™ Optical PM - MRP User ID
Administration Tasks

3-19
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Add a user 3-20

Modify a user 3-22

Delete a user 3-24

Create a user profile 3-25

Modify a user profile 3-26

Delete a user profile 3-28

Section IV: Administer SAGE Desktop
Integration users

3-29

Definition: SAGE Desktop Integration 3-30

Add a user to a SAGE workstation 3-31

Delete a user from a SAGE workstation 3-32
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Section I: User and User Profile Concepts

Overview
....................................................................................................................................................................................................................................

Purpose This section describes user and user profile concepts.

Contents
User and User Profile Concepts 3-4
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User and User Profile Concepts
....................................................................................................................................................................................................................................

The default administrator The Navis™ Optical PM - MRP application is shipped with a default
administrator login that is called sa. This login is used by the initial
user to do initial start-up tasks. This user has access to all Navis™

Optical PM - MRP forms, including those forms that are needed to
add additional new users.

Users who are created by sa are typically set up with access to only a
subset of Navis™ Optical PM - MRP forms. Therefore, to become
authorized, a user has to already have the correct permissions to
access these Navis™ Optical PM - MRP forms or to have the sa
change his or her permissions.

User types and user
profiles

The Navis™ Optical PM - MRP application allows authorized users to
have different levels of access, which are controlled by a login ID, a
password, a user type, and a user profile.

The Navis™ Optical PM - MRP User is the user who has access to
the Navis™ Optical PM - MRP application. By default, this user is of
the type that is called regular user.

A user profile controls which task groupings a user is allowed to
access and thereby which tasks the user is allowed to perform. A user
can be assigned to more than one user profile.

The Navis™ Optical PM - MRP offers the following user profiles:

• The Initial profile provides access to the Configuration
Management and NE Management task groupings. By default, all
new users are assigned to the Initial Profile.

• The Combined profile provides access to the All Tasks task
grouping, which includes the Configuration Management, NE
Management, System Administrator, and Configuration
Management (View only) Administrator task groupings.

While each profile has a finite number of assigned tasks, the system
administrator can select which tasks to associate with a particular
profile.

In addition to the user profiles listed, the system administrator can add
a new profile, or modify or delete an existing profile. The Initial
Profile can never be deleted and the Combined Default Profile cannot
be modified or deleted.

Section I: User and User Profile Concepts Users and User Profiles
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Section II: User Types, User IDs, and Privileges

Overview
....................................................................................................................................................................................................................................

Purpose This section describes Navis™ Optical PM - MRP user types and
contains tasks for creating user IDs using a GUI-based or
terminal-based version of the SAM program. It includes tasks for
assigning user privileges to a user with a Windows® PC or a
Windows® 2000 PC, as well as assigning administrator privileges on
a Windows® PC.

There is no need to add new users on the server. Any necessary user
IDs should have been created during installation.

Navis™ Optical PM - MRP
User types

The following system administrator user types are supported by
Navis™ Optical PM - MRP:

• Navis™ Optical PM - MRP System Administrator, which is the
dacscan user with privileges to start or stop Navis™ Optical PM
- MRP.

• Navis™ Optical PM - MRP Administrator, which is an
application administrator. This user type has sa as its default
administrator user ID and resides in the Navis™ Optical PM -
MRP database as the first real user.

• Regular Users or those users with access to the Navis™ Optical
PM - MRPapplication.

Contents
Create a User ID using the SAM GUI-based
program

3-6

Create a User ID with the SAM terminal-based
program

3-9

Assign User privileges on a Windows® PC 3-13

Assign User privileges on a Windows® 2000 PC 3-15

Assign System Administrator (SA) privileges on a
Windows® PC

3-17

Users and User Profiles
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Create a User ID using the SAM GUI-based program
....................................................................................................................................................................................................................................

Purpose Use this task to create a user ID with the GUI-based version of the
SAM program on an HP-UX workstation.

Task Complete the steps below to create an application user ID using
SAM on an HP-UX workstation.
............................................................................................................................................................

1 Log into the workstation as root.

............................................................................................................................................................

2 On the Common Desktop Environment (CDE) panel (on the bottom of
the screen), select the terminal icon to open a dtterm window.

Result:

A dtterm window is displayed.

............................................................................................................................................................

3 At the prompt, enter sam [Enter].

Result:

A menu of System Administration Manager options is displayed.

............................................................................................................................................................

4 Double click the Accounts for Users and Groups icon.

Result:

The Accounts for User and Groups icons is displayed.

............................................................................................................................................................

5 Double click the Users icon.

Result:

A Displaying All Users form is displayed.

............................................................................................................................................................

6 Select Actions > Add.

Result:

The Add a User Account form is displayed.

Section II: User Types, User IDs, and
Privileges

Users and User Profiles
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............................................................................................................................................................

7 In the Login Name field, enter a value of up to 8 characters for the
ID (such as the person’s abbreviated name) .

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The
first character must be a lowercase letter. The underscores may
be in any position after the first.

Result:

The Home directory field displays the directory path, which
includes the Login Name field’s value, such as
/home/<login_name>.

............................................................................................................................................................

8 Select the Create Home directory box.

Important! The Create Home Directory box must be selected in
order to add the user successfully. If this box is not checked, the
/etc/passwd file may be corrupted and cause the computer to
boot up in single user mode.

............................................................................................................................................................

9 In the Primary Group Name field, enter users.

............................................................................................................................................................

10 In the Start-up Program field, enter /usr/bin/ksh.

Important! The remaining fields are optional.

............................................................................................................................................................

11 Optionally complete the remaining fields, and then click OK to
continue.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

12 Enter a password for the user ID and click OK.

Result:

A verification message is displayed.

............................................................................................................................................................

13 Re-enter the password and click OK.

Section II: User Types, User IDs, and
Privileges
Create a User ID using the SAM GUI-based
program

Users and User Profiles
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Result:

A message indicates that the user ID has been added.

............................................................................................................................................................

14 To exit the Add a User Account form, select File > Exit.

............................................................................................................................................................

15 To exit the Accounts for Users and Groups form, select File > Exit
SAM.

............................................................................................................................................................

16 At the prompt, type cat /etc/passwd | pg and review the passwd
file to ensure that permissions have been set properly for the created
user ID.

............................................................................................................................................................

17 For each user entered in the Login Name field in Step 7 of this task,
complete “Add a user” (3-20) in Chapter 3, “Users and User Profiles”
to add the user to the Navis™ Optical PM - MRP application.

Section II: User Types, User IDs, and
Privileges
Create a User ID using the SAM GUI-based
program

Users and User Profiles
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Create a User ID with the SAM terminal-based program
....................................................................................................................................................................................................................................

Purpose Use this task to create a user ID with the terminal (non-GUI) version
of the SAM program, which may be accessed through a telnet
session.

Before you begin Before you begin this task, you need the IP address of a machine with
the SAM application.

Task Complete the steps below to create a user ID by accessing SAM
through a telnet session.
............................................................................................................................................................

1 Log into a workstation.

............................................................................................................................................................

2 Click the Start button in the task bar, and then select Run.

Result:

The Run dialog box is displayed.

............................................................................................................................................................

3 In the Run dialog box’s Open field, enter telnet
<ip_address_or_hostname> then login as root to the host server
containing the SAM program.

............................................................................................................................................................

4 At the prompt, enter sam [ENTER].

Result:

A message indicates that the terminal version of SAM is started.

............................................................................................................................................................

5 Press Enter.

Result:

The Sam Administration Manager menu is displayed.

............................................................................................................................................................

6 At the highlighted Accounts for Users and Groups selection, press
Enter.

Result:

A menu of User and Group options is displayed.

Section II: User Types, User IDs, and
Privileges

Users and User Profiles
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............................................................................................................................................................

7 Using the down arrow key, highlight Users and press Enter.

Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

8 Using the Tab and arrow keys, scroll to the Actions menu selection
and press Enter.

Result:

The Actions menu is displayed.

............................................................................................................................................................

9 At the highlighted Add... entry, press Enter.

Result:

The Add a User Account form is displayed.

............................................................................................................................................................

10 In the Login Name field, enter a value of up to 8 characters for the
ID (such as the person’s abbreviated name) and press Enter.

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The
first character must be a lowercase letter. The underscores may
be in any position after the first.

Result:

The cursor bypasses the User ID (UID) field, which is populated
already with a system-generated entry. The Home directory
field displays the directory path, which includes the Login Name
field’s value, such as /home/<login_name>.

............................................................................................................................................................

11 Tab to the Create Home Directory check box and press Enter if the
box is not checked already.

Important! The Create Home Directory box must be checked in
order to add the user successfully. If this box is not checked, the
/etc/passwd file may be corrupted and cause the computer to
boot up in single user mode.

............................................................................................................................................................

12 Tab to the Primary Group Name field, type users, and press Enter.
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............................................................................................................................................................

13 In the Start-Up Program field, enter /usr/bin/ksh and press Enter.

Important! The remaining fields are optional.

............................................................................................................................................................

14 Tab to OK and press Enter.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

15 Enter a password for the user ID, tab to OK, and press Enter.

Result:

A verification message is displayed.

............................................................................................................................................................

16 Re-enter the password, tab to OK, and press Enter.

Result:

A message indicates that the login has been added.

............................................................................................................................................................

17 To exit the Add a User Account form, tab to the File menu, highlight
Exit , and press Enter.

............................................................................................................................................................

18 To exit the Accounts for Users and Groups form, tab to the File menu,
highlight Exit SAM, and press Enter.

............................................................................................................................................................

19 At the prompt, type cat /etc/passwd | pg and review the passwd
file to ensure that permissions have been set properly for the created
user ID.

............................................................................................................................................................

20 At the prompt, type exit.

Result:

A logout root and telnet status message are displayed.
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............................................................................................................................................................

21 For each user entered in the Login Name field in Step 10 of this task,
complete “Add a user” (3-20) in Chapter 3, “Users and User Profiles”
to add the user to the Navis™ Optical PM - MRP application.
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Assign User privileges on a Windows® PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to assign user privileges to a user on a PC running
Windows® software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC to complete
this task.

Task Complete the steps below to assign user privileges to a user on a
Windows® PC.
............................................................................................................................................................

1 In the Windows® main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 In the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password for the new user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.
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............................................................................................................................................................

7 (Optional) Uncheck the User Must Change Password at Next
Logon box.

............................................................................................................................................................

8 (Optional) Check the Password Never Expires box.

............................................................................................................................................................

9 Click the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 In the Group Membership screen, view the Member of list for a
Users entry. If Users is not listed, highlight Users in the Not
Member of list and click the Add button.

Important! If an entry other than Users is displayed in the
Member of list, highlight the entry, and then click the Remove
button to move the entry to the Not Member of list.

Result:

Users is displayed in the Member of list.

............................................................................................................................................................

11 In the Group Membership screen, click OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 In the New User screen, click OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen. The user has been assigned user
privileges.
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Assign User privileges on a Windows® 2000 PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to assign user privileges to a user on a PC running
Windows® 2000 software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC to complete
this task.

Tasks Complete the steps below to create a user login on a Windows®
2000 PC.
............................................................................................................................................................

1 Log into a workstation as an administrator.

............................................................................................................................................................

2 In the task bar, click the Start button, and then select Settings >
Control Panel.

Result:

The Control Panel form is displayed.

............................................................................................................................................................

3 Double click the Users and Passwords icon.

Result:

The Users and Passwords form is displayed.

............................................................................................................................................................

4 Click the Add button.

Result:

The Add New User window is displayed.

............................................................................................................................................................

5 Complete the User name, Full name, and Description fields, and
click the Next > button.

Result:

The Add New User form displays the password fields.
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............................................................................................................................................................

6 Complete the Password and Confirm Password fields, and then
click the Next >button.

Result:

The Add New User form displays access selections.

............................................................................................................................................................

7 Click Standard user (or other desired level of access), and then click
the Finish button.

Result:

The user has been assigned user privileges.
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Assign System Administrator (SA) privileges on a Windows®
PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user to a Windows® PC and assign
system administrator privileges.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges to perform this task.

Tasks Complete the steps below to create a system administrator login
and assign system administrator privileges on a Windows® PC.
............................................................................................................................................................

1 In the Windows® main window, click the Start button in the task bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 In the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password for the new user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.

Section II: User Types, User IDs, and
Privileges

Users and User Profiles

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies 3 - 1 7



............................................................................................................................................................

7 Uncheck User Must Change Password at Next Logon.

............................................................................................................................................................

8 Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 In the Group Membership screen, view the Member of list for an
Administrators entry. If Administrators is not listed, highlight
Administrators in the Not Member of list and select the Add button.

Important! If an entry other than Administrators is displayed
in the Member of list, highlight the entry, and then select the
Remove button to move the entry to the Not Member of list.

Result:

Administrators is displayed in the Member of list.

............................................................................................................................................................

11 In the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 In the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.
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Section III: Navis™ Optical PM - MRP User ID Administration
Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer user IDs in the Navis™

Optical PM - MRP application.
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Delete a user profile 3-28
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Add a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user to Navis™ Optical PM - MRP.

Permissions You must have system administrator privileges to complete this task.

Important! Before you begin this task, the user ID must first be
created on the specific platform. See Chapter 2, “Platform
Administration” for details.

Task Complete the following steps to add a user to Navis™ Optical PM
- MRP.
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments > Users > Add.

Result:

The Add User form is displayed.

............................................................................................................................................................

2 In the User ID field, enter a user ID.

............................................................................................................................................................

3 In the Description field, enter a description to be associated with the
user ID. This field is optional.

............................................................................................................................................................

4 In the Profile field, select a user profile from the drop-down list.

The options are:

• Initial

• Provisioning (View Only)

• Combined

If no user profile is selected, the user is assigned the Initial profile
automatically.

Result:

The selected profile is displayed and the tasks associated with
the profile are listed in the Assigned Tasks area of the window.

Section III: Navis™ Optical PM - MRP User
ID Administration Tasks

Users and User Profiles

....................................................................................................................................................................................................................................

3 - 2 0 Lucent Technologies 365-309-803R1.1
Issue 1, July 2002



............................................................................................................................................................

5 In the User Type field, select Regular User.

............................................................................................................................................................

6 Click Apply.

Result:

A message on the bottom of the Add User form indicates that
the user has been added.

............................................................................................................................................................

7 Click OK.

Result:

The Add User form closes.
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Modify a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify user ID information.

Permissions You must have system administrator privileges to complete this task.

Task Complete the following steps to modify a user.
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

2 Highlight the user ID to be modified.

............................................................................................................................................................

3 From the Actions menu, select Modify User.

Result:

The Modify User form is displayed.

............................................................................................................................................................

4 Change the Description, Profile, or User Type parameters as desired.

............................................................................................................................................................

5 Click Apply.

Result:

A message on the bottom of the Modify User form indicates that
the parameters for the selected user have been modified.

............................................................................................................................................................

6 Click OK.

Result:

The Modify User form closes.

............................................................................................................................................................

7 From the List of Users form, select File > Close.
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Result:

The List of Users form closes. The user ID information has been
modified.
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Delete a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a regular user.

Permissions You must have system administrator privileges to complete this task.

Task Complete the following steps to delete a user.
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

2 Highlight the user ID to be deleted.

............................................................................................................................................................

3 From the Actions menu, select Delete User.

Result:

A confirmation box appears and asks if you really want to delete
this user.

............................................................................................................................................................

4 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

5 Select File > Close.

Result:

The List of Users form closes.
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Create a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to create a user profile.

Permissions You must have system administrator privileges to complete this task.

Task Complete the following steps to create a user profile.
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments > Profiles > Add Profile.

Result:

The Add Profile form is displayed.

............................................................................................................................................................

2 In the Profile Name field, enter a name for the user profile (up to 30
characters).

............................................................................................................................................................

3 Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

............................................................................................................................................................

4 Click Apply.

Result:

The user profile is created and is now available for assignment
to users.

............................................................................................................................................................

5 Click OK.

Result:

The Add Profile form closes.

Section III: Navis™ Optical PM - MRP User
ID Administration Tasks

Users and User Profiles

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies 3 - 2 5

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Modify a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the list of tasks associated with a user
profile.

Note that neither the Combined Profile nor the Provisioning (View
Only) Profile can be edited.

Permissions You must have system administrator privileges to complete this task.

Task Complete the following steps to modify a user profile:
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments > Profiles > Modify Profile.

Result:

The Modify Profile form is displayed.

............................................................................................................................................................

2 In the Profile Name field, select the user profile to be modified from
the drop-down list.

Result:

The selected and available tasks for the user profile are
displayed.

............................................................................................................................................................

3 Do one of the following:

• Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

• Remove tasks from the user profile by moving them from the
Selected Tasks list to the Available Tasks list.

............................................................................................................................................................

4 Click Apply.

Result:

The user profile is modified.

............................................................................................................................................................

5 Click OK.
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Result:

The Modify Profile form closes.
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Delete a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user profile.

Note that the Initial Profile cannot be deleted.

Permissions You must have system administrator privileges to complete this task.

Task Complete the following steps to delete a user profile.
............................................................................................................................................................

1 On the Network Map, select Administration > Security
Assignments> Profiles > Delete Profile.

Result:

The Delete Profile form is displayed.

............................................................................................................................................................

2 In the Profile Name field, select the name of the user profile to be
deleted from the drop-down list.

............................................................................................................................................................

3 Click Apply.

Result:

A confirmation box asks if you really want to delete this profile.

............................................................................................................................................................

4 Click Yes.

Result:

The user profile is deleted.

............................................................................................................................................................

5 Click Close.

Result:

The Delete Profile form closes.
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Section IV: Administer SAGE Desktop Integration users

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the Secure Access Gateway
for Enterprises (SAGE) Desktop Integration feature.
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Definition: SAGE Desktop Integration
....................................................................................................................................................................................................................................

SAGE Desktop SAGE Desktop Integration is an optional feature for Navis™ Optical
PM - MRP applications that allows users to access multiple Navis™

Optical PM - MRP systems through a web browser.

A system administrator may add SAGE users to or delete them from
an HP-UX client server.

Since SAGE requires each user to have an individual profile, the
system administrator is responsible for managing these profiles as well
as user logins and passwords. The administrator must also support
users with logging into SAGE, changing passwords, modifying user
attributes, and interpreting and responding to system messages.

Related information For more detailed system administration instructions, see the Secure
Access Gateway for Enterprises (SAGE) Administration Guide.
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Add a user to a SAGE workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user to a SAGE workstation.

Task Complete the steps below to add a user to a SAGE client
workstation.
............................................................................................................................................................

1 Log into the SAGE client workstation as system administrator.

............................................................................................................................................................

2 Click on the IWS icon.

Result:

The IWS Home Page form is displayed.

............................................................................................................................................................

3 Click on the TMS icon.

Result:

The Navis™ Optical PM - MRP Network Map is displayed.

............................................................................................................................................................

4 Select Administration > Security Assignments > Users > Add.

Result:

The Add User form is displayed.

............................................................................................................................................................

5 In the User ID field, enter sawg and then click OK.

............................................................................................................................................................

6 In the Profile field, select Combined Profile from the drop-down list.

............................................................................................................................................................

7 Click on OK on the bottom of the form.

Result:

The user ID is added to the SAGE workstation.
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Delete a user from a SAGE workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user from a SAGE workstation.

Task Complete the steps below to delete a user from a SAGE
workstation.
............................................................................................................................................................

1 Log into the SAGE workstation as system administrator, and then
bring up the Navis™ Optical PM - MRP Network Map.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

3 Highlight the user ID to be deleted.

............................................................................................................................................................

4 From the Actions menu, select Delete User.

Result:

A confirmation box appears and asks if you really want to delete
this user.

............................................................................................................................................................

5 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

6 Select File > Close.

Result:

The List of Users form closes.
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4 System administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks for administering Navis™ Optical PM -
MRP.

Contents
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4-4
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4-8
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4-9

Start Navis™ Optical PM - MRP user interface on a
Windows workstation (PC)
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Section I: Start and Stop the Navis™ Optical PM - MRP server
application

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start and stop the Navis™ Optical PM -
MRP server application.

Background The host application starts when the HP-UX server is brought to run
level 4, and exits when the HP-UX server is brought to run level 3
(multi-user mode). The host application stops whenNavis™ Optical PM
- MRP is brought to run level 3 (multi-user mode).

Contents
Start the Navis™ Optical PM - MRP server
application

4-4

Stop the Navis™ Optical PM - MRP server
application

4-6
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Start the Navis™ Optical PM - MRP server application
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the Navis™ Optical PM - MRP server
application.

Before you begin The first step in starting Navis™ Optical PM - MRP is powering on
the HP-UX server, therefore, before you begin this task, be sure that
the server has been powered on. See “Power on an HP-UX server”
(2-4) in Chapter 2, “Platform Administration”.

Start the Navis™ Optical
PM - MRP server

application

Complete the steps below to start the Navis™ Optical PM - MRP
server application.

............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 3 Oct 30 11:26 3 0 S.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 3, proceed to the next step.

run-level is 4, the application is already running; no
further action is necessary.

run-level is not 3 or 4, contact Lucent Customer Support. (See
the Technical support information
located on the inside of the cover
sheet of this document for details.)

............................................................................................................................................................

4 At the prompt, enter init 4.

Section I: Start and Stop the Navis™ Optical
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Result:

The run level is changed to run-level 4.

............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, press Ctrl and c.

Result:

The following message is displayed:

WS-TMS Application has been started...

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY
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Stop the Navis™ Optical PM - MRP server application
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the Navis™ Optical PM - MRP server
application.

The host application stops whenNavis™ Optical PM - MRP is brought
to run level 3 (multi-user mode).

Stop the Navis™ Optical
PM - MRP server

application

Complete the steps below to stop the Navis™ Optical PM - MRP
server application.

............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A line of current run level information, such as the following, is
displayed:

run-level 4 Oct 30 11:26 3 0 S

..........................................................................................................................................................

3 Continue with one of the following options:

IF THEN

the run-level is 4, proceed to the next step.

the run-level is 3, the application is not running; no
further action is necessary.

run-level is not 3 or 4, contact Lucent Customer Support (see
the Technical support information
located on the inside of the cover
sheet of this document for details).

............................................................................................................................................................

4 At the prompt, enter init 3.

Result:

The run level is changed to run-level 3.
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............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, simultaneously press
Ctrl and c.

Result:

The following message is displayed:

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY

Section I: Start and Stop the Navis™ Optical
PM - MRP server application
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Section II: Start and Exit the Navis™ Optical PM - MRP User
Interface application

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start and exit the Navis™ Optical PM -
MRP User Interface (UI) application on an HP-UX workstation or on
a Windows workstation.

Contents
Start Navis™ Optical PM - MRP user interface on
an HP-UX workstation

4-9

Start Navis™ Optical PM - MRP user interface on a
Windows workstation (PC)

4-10

Exit Navis™ Optical PM - MRP 4-11
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Start Navis™ Optical PM - MRP user interface on an HP-UX
workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the Navis™ Optical PM - MRP user
interface on an HP-UX workstation.

Before you begin Before you begin, be sure that the HP-UX workstation is powered on.
See “Power on an HP-UX workstation” (2-5) in Chapter 2, “Platform
Administration”.

Task Complete the following steps to start Navis™ Optical PM - MRP
on an HP-UX workstation.
............................................................................................................................................................

1 Log into the HP-UX workstation.

..........................................................................................................................................................

2 Continue with one of the following.

IF... THEN...

the Navis™ Optical PM -
MRP icon is displayed on
the desktop:

double-click the icon.

Important! The icon may be displayed
as a Lucent logo.

Result: The Navis™ Optical PM -
MRP Network Map opens.

the icon is not displayed: contact Lucent Customer Support. See
the Technical support information on
the inside of the cover page of this
document for details.

Section II: Start and Exit the Navis™

Optical PM - MRP User Interface
application
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Start Navis™ Optical PM - MRP user interface on a Windows
workstation (PC)
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the Navis™ Optical PM - MRP user
interface on a Windows workstation (PC).

Before you begin Before running Navis™ Optical PM - MRP on a Windows workstation,
the workstation must be powered on (see “Power on a Windows®
workstation” (2-6) in Chapter 2, “Platform Administration”) and the
Navis™ Optical PM - MRP application must be loaded on the
workstation. This task assumes that the application has been loaded on
the workstation.

Task Complete the following steps to start Navis™ Optical PM - MRP
on a Windows workstation.
............................................................................................................................................................

1 Log into the Windows workstation.

Result:

The Windows desktop is displayed.

..........................................................................................................................................................

2 Continue with one of the following.

IF... THEN...

the icon is displayed on the
desktop:

double-click the icon.

Result: The Navis™ Optical PM -
MRP Network Map opens.

the icon is not displayed on
the desktop:

contact the Lucent Customer Support.
(See the Technical support
information on the inside of the cover
sheet of this document for details.)
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Exit Navis™ Optical PM - MRP
....................................................................................................................................................................................................................................

Purpose Use this procedure to exit the Navis™ Optical PM - MRP user
interface application on HP-UX or Windows workstations.

Task Complete the steps below to exit the Navis™ Optical PM - MRP
application.
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box is displayed.

............................................................................................................................................................

2 In the dialog box, select OK.

Result:

The Navis™ Optical PM - MRP session is terminated.
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Section III: Administer the Network Map

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks for controlling the appearance of the
Network Map and for managing network elements on the map.

Contents
Install a new background map 4-13

Set map preferences 4-14

Update a network element position 4-15

Search for controlled network elements 4-16

Search for location-type information for a specific
network element

4-17
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Install a new background map
....................................................................................................................................................................................................................................

Purpose You may install a new background map for HP-UX client machines or
Windows PCs. However, in order to do so, you must call Lucent
Customer Support for assistance. See the Technical support
information on the inside of the cover sheet of this document for
details.

The system administrator will use off-line hardware (such as a
scanner) to scan the customer’s map and save it onto the host machine
as a .gif file in the $DEST/jnm/itm/data/customer directory.

Contact Lucent Customer Support to install a new background map.

Choosing a background
map

A new background map must be selected carefully so that it does not
obscure the icons and text displayed with it. For example, a map that
is largely white will hide the white text of the icon names.

When selecting a background map, select a map that includes colors
that contrast sufficiently with the icons and text displayed on the map
so that they are distinguished easily by the user.

Task Perform the step below to install a new background map for all
users.
............................................................................................................................................................

1 Contact Lucent Customer Support to perform this task.
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Set map preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to set map preferences.

Task Complete the steps below to set map preferences.
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences....

Result:

The Preferences form is displayed.

..........................................................................................................................................................

2 IF THEN

you want to select a
different map

highlight an entry in the User Login
View drop-down list.

you want to set the link
width value

click the Normal or Heavy button.

............................................................................................................................................................

3 Select OK.

Result:

The form closes. Changes to the map will take effect during the
next and subsequent sessions.
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Update a network element position
....................................................................................................................................................................................................................................

Purpose Use the following procedure to update a network element’s position
on the Network Map.

Permissions You must have system administrator or Configuration Management
privileges to save the updated network element positions on the
Network Map.

Task Complete the steps below to move a node permanently to a new
position on the Network Map.
............................................................................................................................................................

1 On the Network Map, select the node you want to move.

............................................................................................................................................................

2 Drag and drop the node to the new location.

Result:

The node and its connecting links are repositioned.

............................................................................................................................................................

3 On the Network Map, select File > Save Node & Label Map
Positions.

Result:

The network element’s location is updated.
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Search for controlled network elements
....................................................................................................................................................................................................................................

Purpose Use this procedure to search for a list of network elements with which
Navis™ Optical PM - MRP works and for information about the
digital cross-connect systems that are part of the network.

Task Complete the steps below to search for controlled network
elements and digital cross-connect systems that are part of the
network.
............................................................................................................................................................

1 On the Network Map, select Administration > Location Reference
Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

2 (Optional) In the Office Location/NE ID field, enter any known
network element information to use as search criteria.

............................................................................................................................................................

3 (Required) Select the Area ID from the drop-down list.

............................................................................................................................................................

4 (Optional) Select the Node Type from the drop-down list.

............................................................................................................................................................

5 Click OK.

Result:

The Location Reference Table form displays the results.
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Search for location-type information for a specific network
element
....................................................................................................................................................................................................................................

Purpose Use this procedure to search for location-type information for a
specific network element.

Important! The search is limited to network elements that are
controlled or cataloged by Navis™ Optical PM - MRP.

Task Complete the steps below to search for location-type information
for a specific network element.
............................................................................................................................................................

1 On the Network Map, select Administration > Location Reference
Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

2 (Required) In the Office Location/NE ID field, enter the network
element ID.

............................................................................................................................................................

3 (Required) Select the Area ID from the drop-down list.

............................................................................................................................................................

4 (Optional) Select the Node Type from the drop-down list.

............................................................................................................................................................

5 Select OK.

Result:

The Location Reference Table displays location-type information
for the specific network element.
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Section IV: Administer user-defined submaps

Overview
....................................................................................................................................................................................................................................

Purpose This section defines how to add, modify, and delete Navis™ Optical
PM - MRP user-defined submaps.

You need the Initial or Combined profile to administer user-defined
submaps.

Important! Each user may add a maximum of ten user-defined
submaps.

Contents
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Display/modify a user-defined submap 4-20

Delete a user-defined submap 4-21
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Add a user-defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user-defined submap.

Important! Each user may add a maximum of ten user-defined
submaps.

Permissions You must have the Initial or Combined profile to complete this task.

Task Complete the steps below to add a user-defined submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Add.

Result:

The Add User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, enter a name for the
user-defined submap.

............................................................................................................................................................

3 To add nodes to the new submap, select one or more entries from the
Non-Members list, and then click the left arrow button.

Important! You may complete the Filters field to lessen the
number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 Select OK.

Result:

The new user-defined submap is added, and the Add User
Defined Submap form closes.
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Display/modify a user-defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to display or modify a user-defined submap.

Permissions You must have the Initial or Combined profile to complete this task.

Task Complete the steps below to display or modify a user-defined
submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Display/Modify

Result:

The Modify User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select the submap to be
displayed or modified.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add nodes to the submap by selecting one or more entries from
the Non-Members list and clicking the left arrow button.

• Remove nodes from the submap by selecting one or more entries
from the Members list and clicking the right arrow button.

............................................................................................................................................................

4 Click OK.

Result:

The submap is modified if changes were made.
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Delete a user-defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user-defined submap.

Permissions You must have the Initial or Combined profile to complete this task.

Task Complete the steps below to delete a user-defined submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Delete

Result:

The Delete User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select a map name from
the pull down menu.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Click OK.

Result:

The user-defined submap is deleted.
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Section V: Administer the Oracle database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to restart and stop the Oracle database.
Start and stop the Oracle database only when necessary, for example,
when backing it up.

Definition: Oracle database The Oracle database is used to retain persistent copies of application
and customer data. Use of Oracle’s Transaction Processing Option
enables concurrent control and a high degree of data integrity.

Important Starting and stopping the database should be performed only at the
discretion of Lucent Customer Support.

Contents
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Restart the Oracle database
....................................................................................................................................................................................................................................

Purpose Use this procedure to restart the Oracle database.

Important! This procedure should be performed only at the
discretion of Lucent Customer Support.

Task Complete the steps below to restart the Oracle database.
............................................................................................................................................................

1 From the system console, log in as oracle.

............................................................................................................................................................

2 At the prompt, enter /usr/dacscan/toolbin/startdb.sh.

Result:

A message indicating that the database has been started is
displayed on the form.
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Stop the Oracle database
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the Oracle database.

Important! This procedure should be performed only at the
discretion of Lucent Customer Support.

Task Complete the steps below to stop the Oracle database.
............................................................................................................................................................

1 From the system console, log in as oracle.

............................................................................................................................................................

2 Stop the application on the server.

Reference:

For instructions, see “Stop the Navis™ Optical PM - MRP server
application” (4-6) earlier in this chapter.

............................................................................................................................................................

3 At the prompt, enter /usr/dacscan/toolbin/shutdb.sh.

Result:

A message indicating that the database has been stopped is
displayed on the form.
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Section VI: Administer the system cron file

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the system cron file.

Background The cron file contains commands that are executed automatically at
set times.

The cron file may be edited; however, cron files should be edited only
at the discretion of Lucent Customer Support.

There are two types of cron files, which operate independently:

• root cron, which includes various administrative functions that
are executed on a routine basis, such as daily backups and file
system space monitoring

• dacscan cron, which includes various application-related
functions, such as database syncs and auto-implementation

File format In the read-only root cron file, entries on the active line are separated
by blanks or tabs. Each field of the active line correlates to a subset
of time. The following is an example of an active line, with each field
separated by a tab (indicated by -->):

min-->hour-->day-->month-->day-of-week-->command min: 0-59
hour: 0-23 day:1-31 month:1-12 day of week: 0-6 (Sunday=0)
command: program to be executed

In place of numerics, an asterisk (*) may be used as a wild card to
indicate the whole range. A sample active line may look like the
following:

01 04,23 * * * ksh /usr/dacscan/bin/auto_backup &

This line specifies that the auto_backup will execute in the
background one minute past the 4th hour and, again, one minute past
the 23rd hour, every day of the month, every month, and every day of
the week.
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View the dacscan cron file 4-28

Edit the root cron file 4-29

Edit the dacscan cron file 4-30
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View the root cron file
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the root cron file.

Important! The root cron file is a read-only file. It can be edited
only by the superuser (root user).

Task Complete the steps below to view the system cron file.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 At the # prompt, enter crontab -l [Enter].

Result:

The root cron file is displayed.
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View the dacscan cron file
....................................................................................................................................................................................................................................

Purpose Use this task to view the dacscan cron file.

Important! The dacscan cron file is a read-only file. It can be
edited only by the superuser (root user).

Task Complete the steps below to view the dacscan cron file.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

Important! Using the root login, you may enter su - dacscan
and enter the dacscan password.

............................................................................................................................................................

2 At the # prompt, enter crontab -l [Enter].

Result:

The dacscan cron file is displayed.
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Edit the root cron file
....................................................................................................................................................................................................................................

Purpose Use this procedure to change the desired execution times of
commands in the root cron file.

Permissions You must have root permissions to edit the root cron file. Before
editing this file, it is recommended that you first create a copy of each
file, then delete the copy when it is no longer needed.

Task Complete the steps below to edit the root cron file.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 At the # prompt, enter crontabs -e.

Result:

The root cronfile is opened in edit mode.

............................................................................................................................................................

3 Edit the desired parameter.

............................................................................................................................................................

4 Save and close the file.

Result:

When you quit the file, the root cron file is loaded automatically
into the system cron.
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Edit the dacscan cron file
....................................................................................................................................................................................................................................

Purpose Use this procedure to change the desired execution times of
commands in the dacscan cron file.

Permissions You must have dacscan permissions to edit the dacscan cron file.
Before editing this file, it is recommended that you first create a copy
of each file, then delete the copy when it is no longer needed.

Task Complete the steps below to edit the dacscan cron file.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

............................................................................................................................................................

2 At the # prompt, enter crontabs -e.

Result:

The dacscan cron file is opened in edit mode.

............................................................................................................................................................

3 Edit the desired parameter.

............................................................................................................................................................

4 Save and close the file.

Result:

When you quit the file, the dacscan cron file is loaded
automatically into the system cron.
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5 Provisioning Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains topology and provisioning tasks performed to
administer Navis™ Optical PM - MRP.
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Section I: Aggregates

Overview
....................................................................................................................................................................................................................................

Purpose An aggregate is a collection of one or more network elements
collapsed into a single node displayed on the Network Map. An
aggregate can contain other aggregates.

This section discusses the provisioning tasks associated with
aggregates as they relate to managing the topology of the Navis™

Optical PM - MRP Network Map.

Contents
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Display/Modify an Aggregate 5-6
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Add an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to add an aggregate to the Navis™ Optical PM
- MRP Network Map.

Task Complete the following task to add an aggregate to the Navis™

Optical PM - MRPNetwork Map.
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 In the Aggregate ID field, enter a 1 to 20 character name for the
Aggregate ID.

............................................................................................................................................................

4 In the Acronym field, enter a 1 to 4 character name for the aggregate
Acronym.

............................................................................................................................................................

5 From the Non-Members List, select the network element or elements
you want to add to the aggregate.

Important! To select more than one network element, press the
Shift with the up or down arrow key. The number of network
elements that can be selected at one time is unlimited.

............................................................................................................................................................

6 Click the left arrow to move the network elements appearing in the
Non-Members list to the Members list.

Result:

The selected network elements appear within the Members list.

............................................................................................................................................................

7 Click OK.
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Result:

A confirmation window is displayed.

............................................................................................................................................................

8 On the confirmation window, click OK.

Result:

The confirmation window and the Aggregate Add form close.

............................................................................................................................................................

9 To display the new aggregate, from the Network Map’s Expand Area
field, select the area to which the aggregate was added from the
drop-down menu.

Result:

An Aggregate icon is displayed in the Expanded Area section of
the Network Map.
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Delete an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete an aggregate from the Navis™ Optical
PM - MRP Network Map.

Task Complete the following task to delete an aggregate from the
Navis™ Optical PM - MRP Network Map.
............................................................................................................................................................

1 From the Network Map, select Administration> Aggregate > Delete.

Result:

The Aggregate Delete form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 Click the Aggregate ID to be deleted.

............................................................................................................................................................

4 Click OK.

Result:

A confirmation window is displayed.

............................................................................................................................................................

5 On the confirmation window, click OK.

Result:

The Aggregate Delete form and confirmation windows close.
The aggregate is deleted and is no longer displayed on the
Network Map.
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Display/Modify an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to display or modify aggregate information.
Changes are made to an aggregate by adding members to or removing
members from an existing aggregate. Members are represented by
network element or office location IDs.

Important! There is not a limit on the number of members that
may reside in an aggregate.

Task Complete the following task to display or modify an existing
aggregate.
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate >
Display/Modify.

Result:

The Aggregate Modify form displays.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 In the Aggregate ID pull-down menu, click the aggregate to be
displayed.

Result:

The selected aggregate displays and its associated members are
displayed in the Members column.

..........................................................................................................................................................

4 Continue with one of the following options.

IF THEN

you want to do not want to
modify information,

select the Close button to complete
this task.

you want to modify
information,

proceed to the next step to continue.
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............................................................................................................................................................

5 In the Members or Non-Members list, select the network element(s)
to be moved, click the left or right arrow to move the network
elements to or from the list.

Result:

The network element(s) moves to the alternate list.

............................................................................................................................................................

6 Click OK.

Result:

A confirmation window is displayed.

............................................................................................................................................................

7 On the confirmation window, click OK.

Result:

The Confirmation window and Aggregate Modify form closes.

Section I: Aggregates
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Section II: User Defined Submap

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined submaps which allow a specific user to define what areas to
display on the screen.

Contents
Add a User Defined Submap 5-9

Display/Modify a User Defined Submap 5-10

Delete a User Defined Submap 5-11
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Add a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to add a user defined submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Add.

Result:

The Add User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, enter a name for the user
defined submap.

............................................................................................................................................................

3 In the Area ID field, select an area from the drop-down menu.

............................................................................................................................................................

4 In the Non-Member List area of the form, select the Node or
Aggregate button.

............................................................................................................................................................

5 To add member(s) to the new submap, select one or more entries from
the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to
lessen the number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

6 Select OK.

Result:

The new user defined submap is added and the Add User
Defined Submap form closes.

Section II: User Defined Submap Provisioning Administration
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Display/Modify a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to display/modify a user defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to display/modify a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Display/Modify.

Result:

The Modify User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select the submap to be
displayed/modified from the drop-down menu.

Result:

The selected information displays.

............................................................................................................................................................

3 Select the first or subsequent options then proceed to the next step.

• Make no changes to the form.

• Change the Area ID and/or Non-Member List information.

• Add member(s) to the submap by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the submap by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 Continue with one of the following options.

• If changeswere not made to the form, select Close.

• If changeswere made to the form, select OK.

Result:

The submap is modified if changes were made.
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Delete a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to delete a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Delete.

Result:

The Delete User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select a name from the
drop-down menu.

Result:

The selected name displays.

............................................................................................................................................................

3 Select OK.

Result:

The user defined submap is deleted.
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6 Environment provisioning

Overview
....................................................................................................................................................................................................................................

Purpose Provisioning the environment setup involves using off-line tools to
support inter-domain provisioning for Navis™ Optical PM - MRP.

Provisioning the environment setup is supported by the following
off-line tools:

• Bulk Link Provisioning Tool

• Merge Circuits Tool

• Inter Domain Link and Path Manager (IDLPM) Tool

Provisioning DMSs have been added and their databases populated during
installation.

To provision the environment set-up, is recommended that the
following tasks are completed in this order:

1. Provision links with the Bulk Link Provisioning Tool

2. Merge circuits with the Merge Circuit Tool

After these tasks are completed, it is recommended that you
synchronize the databases. Refer to “Section I: Synchronize the
database” (7-2) in Chapter 7, “Network communication management”.
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IDLPM The IDLPM tool is used to migrate inter-domain link and path data
from the IDLPM application to the Navis™ Optical PM - MRP
application. This tool is run on the IDLPM and Navis™ Optical PM -
MRP applications. In addition to running the IDLPM tool, the Bulk
Link Provisioning and Merge Circuit tools must be run on Navis™

Optical PM - MRP to complete the IDLPM migration process.

Contents
Section I: Provision links 6-3

Provision links with the Bulk Link Provisioning
Tool

6-6

Section II: Merge circuits 6-7

Merge circuits with the Merge Circuit Tool 6-9

Section III: IDLPM Tool 6-11
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Section I: Provision links

Overview
....................................................................................................................................................................................................................................

Purpose

This section describes the bulk link provisioning tool, which is used
to perform a bulk transfer of topological links from provisioning
systems (for example, an external Circuit Record System) to Navis™

Optical PM - MRP. This off-line tool abstracts the topological links
into a bulk process and then performs a bulk add of the links to
Navis™ Optical NMS as if they were added individually through the
Navis™ Optical NMS GUI.

Refer to the Navis™ Provisioning Manager - Multi-Regional
Provisioning (MRP) Provisioning Guide (365-309-804) for
information on provisioning individual links.

Input file Before running this tool, an input file must be created. This file must
be created in the /tmp/net_entity directory and named
Bulk_Link_Input_File. The input file is entered in the bulk link
provisioning tool command.

Input file format The Bulk_Link_Input_File includes one line per NMS or Navis™

Optical PM - MRP link to be provisioned.

When you are creating the Bulk_Link_Input_File, remember the
following:

• each line represents a digital link

• each field is separated by a pipe ( | )

• each line (digital link) is separated by a [RETURN]

The following is the format for the Bulk_Link_Input_File:

link_type|link_ID|aloc|zloc|A_office_id|Z_office_id|A_

port|Z_port|a_frame|z_frame|a_intfc_port|z_intfc_port|ATP_

type|ZTP_type|A_prot_port|Z_prot_port|a_prot_frame|z_prot_

frame|a_intfc_prot_port|z_intfc_prot_port|ATP_prot_

type|ZTP_prot_type|Prot_type or msp |msp_type|prot_link_

ID|Prot_group|linkname

Environment provisioning

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies 6 - 3



The fields are defined as follows:

link_type the coded “rate” of the link

link_ID free-format label intended for the NMS or
Navis™ Optical PM - MRP Circuit ID field

aloc full A NE TID. The “A” network element
identifier as known to NMS or Navis™

Optical PM - MRP

zloc full Z NE TID. The “Z” network element
identifier as known to NMS or Navis™

Optical PM - MRP

A_office_id office ID at the A location

Z_office_id office ID at the Z location

A_port EMS-level port address of the service link at
the A location

Z_port EMS-level port address of the service link at
the Z location

a_frame NLS-level port address

z_frame NLS-level port address

a_intfc_port derived from a_port

z_intfc_port derived from z_port

ATP_type ptp | ctp | ftp (note: ftp is a floating port)

ZTP_type ptp | ctp | ftp

A_prot_port EMS-level port address of the Protecting
Link at the A_location

Z_prot_port EMS-level port address of the Protecting
Link at the Z_location

a_prot_frame NLS-level port address

z_prot_frame NLS-level port address

a_intfc_prot_port derived from a_port2

z_intfc_prot_port derived from z_port2

ATP_prot_type ptp_port.tptype

ZTP_prot_type ptp_port.tptype

prot_type or msp coded MSP configuration as “1X1MSP” or
“1+1MSP” or “NONE”

Section I: Provision links
Overview

Environment provisioning

....................................................................................................................................................................................................................................

6 - 4 Lucent Technologies 365-309-803R1.1
Issue 1, July 2002



msp_type type of MSP configuration: UNI or BI

prot_link_ID free-format label denoting the protecting
link or “NONE”

prot_group MSP Protection Group Name for 1X1MSP

linkname interface name for the link

Contents
Provision links with the Bulk Link Provisioning
Tool

6-6

Section I: Provision links
Overview

Environment provisioning

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies 6 - 5



Provision links with the Bulk Link Provisioning Tool
....................................................................................................................................................................................................................................

Purpose This section describes how to perform bulk link provisioning in
Navis™ Optical PM - MRP.

Important! Run this tool during off-hours to avoid impact on
system response. If this is your first time using this tool, contact
Lucent Customer Support for assistance.

Task Complete the steps below to run the bulk link provisioning tool.
............................................................................................................................................................

1 Log into the Navis™ Optical PM - MRP server as dacscan.

............................................................................................................................................................

2 Enter the following commands:

mkdir /tmp/net_entity

cd /tmp/net_entity

............................................................................................................................................................

3 In the /tmp/net_entity directory, create an input file called
Bulk_Link_Input_File. Refer to the Overview of this section for the
Bulk_Link_Input_File format.

............................................................................................................................................................

4 Save and close the file, and then select one of the following options
from the next step.

............................................................................................................................................................

5 Run the command by entering
/usr/dacscan/toolbin/offline/net_entity.ksh -i -n digital link -f
Bulk_Link_Input_File

Other options for this tool include:

• -h: to print a usage message

• -b: to run in batch mode. No input file confirmation requested.

• -v: to validate the input file in preparation. Do not process.

............................................................................................................................................................

6 Verify the error or log file by looking in
/tmp/net_entity_DATE_TIME.
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Section II: Merge circuits

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the Navis™ Optical PM - MRP Merge Circuit
tool which supports the merging of in-effect, inter-domain
circuits/paths.

About this tool The Navis™ Optical PM - MRP Merge Circuit tool searches the
Navis™ Optical PM - MRP database for inter-domain links that can be
used for merge processing. This tool maintains a list of inter-domain
link port candidates. It updates the list when an inter-domain link’s
port has been used so no attempts will be made to use it in future
processing.

The Navis™ Optical PM - MRP Merge Circuit tool next locates a path
which both terminates on an inter-domain link port and has a
continuation in a neighboring domain. The tool then updates the
Navis™ Optical PM - MRP database with the merge operation and
instructs Navis™ Optical NMS to update the DMS userLabel field
with the name of the merged circuit.

Input file The Navis™ Optical PM - MRP Merge Circuit tool uses an input data
file, which is an ASCII text file with multiple non-empty lines.

Each line contains fields separated by a pipe (|). There is no | at the
beginning of the line, but a | must be present at the end of the line.

The tool can handle multiple merged circuits in one file. For each
merged circuit in the file, there should be a ″PATH_BEGIN″ line, the
text line, and a ″PATH_END″ line. These lines must end with a pipe (
| ).

Input file format The following is the format for the Input data file:

PATH_BEGIN|

merged_ckt_id|a_loc|z_loc|a_port|z_port|prot_

type|a.prot.loc|z_prot_loc|a_prot_port|z_prot_port|

to_be_merged_ckt_id1|

to_be_merged_ckt_id2|

Environment provisioning
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...

to_be_merged_ckt_idN|

PATH_END|

PATH_BEGIN|

...

...

PATH_END|

Contents
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Merge circuits with the Merge Circuit Tool
....................................................................................................................................................................................................................................

Purpose This section describes how to merge circuits with the Navis™ Optical
PM - MRP Merge Circuit Tool.

Before you begin Before running the Navis™ Optical PM - MRP Merge Circuit tool,
note the following conditions:

• You must create an input file.

• All inter- and intra-domain paths/circuits must be in the In Effect
state.

• The merge will be valid only on paths with no circuits riding on
them.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete the steps below to run the Navis™ Optical PM - MRP
Merge Circuit tool.
............................................................................................................................................................

1 Log into the server as dacscan.

............................................................................................................................................................

2 Enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Run the Merge Circuit tool by entering ./pathMerge <input data file
path name>

Result:

The Navis™ Optical PM - MRPMerge Circuit tool does the
following:

• searches the Navis™ Optical PM - MRP database for
inter-domain links and their endpoints that can be used for
merge processing.

• searches the Navis™ Optical PM - MRP database for
intra-domain paths terminating on the identified end port.

Section II: Merge circuits Environment provisioning
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• merges circuits across the inter-domain link by populating
the DMS Userlabel field with the circuit ID of one of the
merged circuit’s component circuits. The inter-domain link
is then marked as used.

• verifies whether or not the circuit is cross-connected. If it
is, the tool searches for additional inter-domain links across
which it may be merged. If it is not, then the tool returns to
the list of inter-domain link port candidates to perform
additional processing.

• produces audit logs containing positive and negative results
of the Merge Circuit Tool and stores them in log files.

If the user has provisioned a black box to a node, and the Navis™

Optical PM - MRP user wants to provision an inter-domain link
between this node and another node in another domain to which it
also may or may not be provisioned , the operation from Navis™

Optical PM - MRP may be successful, but the order implementation at
Navis™ Optical NMS will fail. This will occur since the port(s) are in
use by the link to the black box(es).

In this case, it is recommended that the user first delete the black
boxes locally at the relevant Navis™ Optical NMS and then create the
inter-domain link from Navis™ Optical PM - MRP.

When the user requests to merge a number of subnetwork connections
from Navis™ Optical PM - MRP, if one or more of the requests fail to
lower level management system, the Navis™ Optical PM - MRP will
display a message indicating that the merge update of the Navis™

Optical PM - MRP circuit ID failed for the Navis™ Optical NMS
circuit ID in Navis™ Optical NMS. The merge will complete, but
setUserLabel will fail. In this case, the user will have to modify the
circuit ID locally in the appropriate network management system
through modify order parameters.

Section II: Merge circuits
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Section III: IDLPM Tool

Overview
....................................................................................................................................................................................................................................

Purpose The IDLPM tool is used to extract inter-domain data from the IDLPM
application and to load it into the Navis™ Optical PM - MRP. The tool
needs to migrate over all the inter-domain digital links and the
information necessary for Navis™ Optical PM - MRP in order to
associate the IDs of the inter-domain paths, the merged names, with
all their constituent inter-domain and intra-domain segments. The
merged name is the name given to the end-to-end path whose segment
spans multiple DMS domains.

Processing Requirements The script must be separately run in the IDLPM and Navis™ Optical
PM - MRP applications.

IDLPM Processing Results This script produces the following results on the Navis™ Optical PM -
MRP machine used for the IDLPM to Navis™ Optical PM - MRP data
migration:

• Provisions inter-domain digital links

• Merges path segments into end-to-end inter-domain paths.

• Updating customer name information of end-to-end inter-domain
paths.

Contents
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IDLPM Tool
....................................................................................................................................................................................................................................

Purpose This task describes how to run the IDLPM tool.

Processing Order This script is first run in the IDLPM application and next run in the
Navis™ Optical PM - MRP applications. After the script completes on
Navis™ Optical PM - MRP, the Bulk Link Provisioning and Merge
Circuit scripts must be run.

Before you begin Note the following:

• A database backup of the Navis™ Optical PM - MRP system
machine should be made prior to each data modification phase.
In the event of failure of any phase, the system can be restored
to its previous state by applying the appropriate backup.

• A clean, Navis™ Optical PM - MRP must be started up and
connected to DMSs. In all likelihood, the DMSs will be
connected to the Navis™ Optical PM - MRP sequentiall The
migration can only proceed once all the DMSs are online with
the Navis™ Optical PM - MRP.

• Before performing an IDLPM migration toNavis™ Optical PM -
MRP, be sure that a database sync has occurred with each DMS.
This enables Navis™ Optical PM - MRP to be populated with
intra-domain network data from all of the DMSs.

• The IDLPM component of the migration tool will retrieve only
inter-domain digital links.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Perform the following steps to extract inter-domain data from the
IDLPM application and to load it into the Navis™ Optical PM -
MRP.
............................................................................................................................................................

1 Back up the Navis™ Optical PM - MRP system machine. See the
backup tasks in Chapter 8, “System maintenance”.

Result:

The Navis™ Optical PM - MRP system machine is backed up.
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............................................................................................................................................................

2 Stop the IDLPM application. .

Result:

The IDLPM application is stopped.

............................................................................................................................................................

3 At the prompt, enter GET_INTERDOMAIN_LINKS_PATHS.BAT.

Result:

The scripts will access the IDLPM SQL Server database using
the sqladmin login. The scripts run in the Windows® 2000
environment under the Administrator username. Upon
completion, the following batch files are produced:
idlpm_digital_link.dat.YYMMDD.HH:MI:SS and
idlpm_path.dat.YYMMDD.HH:MI:SS.

............................................................................................................................................................

4 Use ftp to copy the idlpm_digital_link.dat.YYMMDD.HH:MI:SS and
idlpm_path.dat.YYMMDD.HH:MI:SS files to the Navis™ Optical PM -
MRP host server.

Result:

The files are transferred from the IDLPM machine to the
Navis™ Optical PM - MRP host machine’s
/tmp/net_entity/idlpm_migration directory.

............................................................................................................................................................

5 Log into the Navis™ Optical PM - MRP host as dacscan.

............................................................................................................................................................

6 At the prompt, enter cd /usr/dacscan/toolbin

Result:

The prompt resides at the directory where the migration tool is
located.

............................................................................................................................................................

7 At the prompt, enter GET_INTERDOMAIN_LINKS_PATHS.BAT.

Result:

The script manipulates the inter-domain digital link file in order
to prepare it as input for the Navis™ Optical PM - MRP

Section III: IDLPM Tool
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inter-domain digital link bulk-provisioning tool. This step can
take up to an hour to complete.

............................................................................................................................................................

8 Upon completion of the last step, at the prompt, enter cd
~dacscan/toolbin/offline and type ./net_entity.ksh –n digital_link
–ip –f tms_digital_link.dat.”date” or ./net_entity.ksh –n digital_link
–ip –f invalid_digital_link.dat.”date” .

Result:

The Bulk Link tool is run and the inter-domain digital links file
is loaded into the Navis™ Optical PM - MRP. Upon completion,
the Navis™ Optical PM - MRP component of the migration tool
manipulates the inter-domain paths file in order to prepare it as
input for the Navis™ Optical PM - MRP Merge tool.

............................................................................................................................................................

9 At the prompt, enter cd /dacscan/toolbin/pathMerge
/tmp/net_entity/tms_path_merge.dat.”date” or cd
/dacscan/toolbin/pathMerge
/tmp/net_entity/invalid_path_merge.dat.”date”.

Result:

The Navis™ Optical PM - MRP Merge tool is run which causes
inter-domain paths in the Navis™ Optical PM - MRP to be
inventoried, and the end-to-end path(s) to be merged are
discovered.
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7 Network communication
management

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides tasks for interacting with subsystems in the
network.

Contents
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Section I: Synchronize the database

Overview
....................................................................................................................................................................................................................................

Purpose This section provides information on synchronizing the Navis™

Optical PM - MRP database with the DMS database.

Contents
Synchronize the Navis™ Optical PM - MRP
database with a DMS database

7-3
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Synchronize the Navis™ Optical PM - MRP database with a
DMS database
....................................................................................................................................................................................................................................

Purpose Use this procedure to synchronize the Navis™ Optical PM - MRP
database with a DMS database.

The Navis™ Optical PM - MRP and Navis™ Optical NMS databases
should be synchronized under the following circumstances:

• if communication between Navis™ Optical NMS and Navis™

Optical PM - MRP is down

• if Navis™ Optical NMS has been down and is brought back up

Important! Navis™ Optical NMS allows the user to create subnetwork
connection (SNC) at the Navis™ Optical NMS level without the
creation of Port (PTP). At the Navis™ Optical PM - MRP level, when
a database synchronization is performed, the SNC will not be reported
to Navis™ Optical PM - MRP since this application makes requests
based on PTPs.

Task Complete the steps below to synchronize the Navis™ Optical PM
- MRP database with a DMS database.
............................................................................................................................................................

1 On the Network Map, select File > Open Controller Map.

Result:

The DMS Controller Map is displayed.

............................................................................................................................................................

2 Right-click the DMS node you wish to synchronize with Navis™

Optical PM - MRP.

............................................................................................................................................................

3 Select Session > Start Synchronization.

Result:

The Database Download/Synchronization form is displayed. The
DMS ID field is pre-populated with the name of the DMS.
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............................................................................................................................................................

4 In the Sync Type field, select one of the following:

• Network Elements to synchronize with Navis™ Optical PM -
MRP all the network elements and containing subnetworks
managed by the DMS. Navis™ Optical PM - MRP inventories the
following for each network element: name, type, version, and
communication status.

• Topological Links to synchronize with Navis™ Optical PM -
MRP all the physical connectivities that exist between the
network elements within the DMS.

• Subnetwork Connections to synchronize with Navis™ Optical
PM - MRP all paths and circuits that exist within the DMS.

............................................................................................................................................................

5 Select Apply.

Result:

A confirmation form is displayed.

............................................................................................................................................................

6 Select Yes.

Result:

The Database Synchronization Status form is displayed.

............................................................................................................................................................

7 Wait for the synchronization to complete.

............................................................................................................................................................

8 Select Close.

Result:

The Navis™ Optical PM - MRP database is synchronized with
the DMS database.
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8 System maintenance

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks for ensuring the reliability of Navis™

Optical PM - MRP by backing up and recovering the database. It also
provides a task for monitoring system space.

Contents
Section I: Back up the database 8-2

Perform a hot backup 8-4

Perform a cold backup 8-5

Section II: Recover the database 8-7

Perform a hot backup recovery 8-8

Perform a cold backup recovery 8-10

Section III: Monitor space 8-12

Monitor space 8-13
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Section I: Back up the database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of backups.

Scheduled backups The system can be set to perform daily backups. The time for the
daily backups is set in the cron file. For information on how to edit
the cron file, see “Section VI: Administer the system cron file” (4-25)
in Chapter 4, “System administration”.

Host database backups Two types of backups are available:

• hot backup

• cold backup

Hot backups run when the system is up and running (hot). Cold
backups run when Navis™ Optical PM - MRP is shut down (cold). A
hot backup takes longer to complete than a cold backup, but a hot
backup can be initiated while Navis™ Optical PM - MRP is running.
The application must be stopped before a cold backup can be run.

Hot backups There are two types of hot backups:

• automatic

• user-initiated

The system automatically backs up the database on Sunday, Tuesday,
Wednesday, Thursday, and Friday at 2:00 a.m. if a tape is present in
the tape drive. The system must be at run level 4 for a hot backup to
run.

The hot backup takes from 60 to 180 minutes to complete, depending
on the size of the database. No operator action is required during the
hot backup. The default database backup retention is 5 days (5
tapes/rotation).

It is recommended that hot backups are performed nightly. The
frequency and time of automatic hot backups can be altered in the
cron file.

System maintenance
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Cold backups A cold backup is the most accurate type of backup. Operator action is
required during the cold backup procedure; the system must be
brought to run level 3 for a cold backup.

Cold backups should be run weekly, or at least monthly.

Contents
Perform a hot backup 8-4

Perform a cold backup 8-5

Section I: Back up the database
Overview
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Perform a hot backup
....................................................................................................................................................................................................................................

Purpose A hot backup is run when the system is up and running.

Task Complete the steps below to perform a hot backup.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 Remove the daily backup tape and insert a blank tape for the hot
backup in the drive.

............................................................................................................................................................

3 When the lights on the tape drive stop flashing, enter the following
command:

/bin/ksh /usr/dacscan/bin/hot_backup

Result:

The hot backup begins and takes approximately 60-180 minutes
to complete, depending on the size of the database. The #
prompt is displayed on the system console once the backup is
complete.

............................................................................................................................................................

4 Remove the hot backup tape.

............................................................................................................................................................

5 Label the tape hot backup and add the following information:

• current date

• server name

............................................................................................................................................................

6 Store the tape in a safe place.

............................................................................................................................................................

7 Replace the daily backup tape in the drive.

Result:

The hot backup is complete.

Section I: Back up the database System maintenance
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Perform a cold backup
....................................................................................................................................................................................................................................

Purpose Run a cold backup when Navis™ Optical PM - MRP is shut down
(cold).

Task Complete the steps below to perform a cold backup.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 Stop Navis™ Optical PM - MRP.

Reference:

For instructions, see “Stop the Navis™ Optical PM - MRP server
application” (4-6) in Chapter 4, “System administration”.

............................................................................................................................................................

3 Log in to the Navis™ Optical PM - MRP server as root.

............................................................................................................................................................

4 Remove the daily backup tape and insert the cold backup tape in the
drive.

............................................................................................................................................................

5 When the lights on the tape drive stop flashing, enter the following
command:

/bin/ksh /usr/dacscan/bin/cold_backup

Result:

The cold backup begins and takes approximately 40 minutes to
complete. The # prompt is displayed on the system console once
the backup is complete.

............................................................................................................................................................

6 Remove the tape.

............................................................................................................................................................

7 Label the tape cold backup and add the following information:

• current date

• server name

Section I: Back up the database System maintenance
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............................................................................................................................................................

8 Store the cold backup tape in a safe place.

............................................................................................................................................................

9 Replace the daily backup tape in the drive.

Result:

The cold backup is complete.

............................................................................................................................................................

10 At the prompt, enter shutdown -r -y 0 to reboot the server and
clean up UNIX system files.

Result:

The server will shut down and restart. This will take
approximately 10 minutes; the prompt is displayed again once
the process is complete.

............................................................................................................................................................

11 Log into the server as root.

............................................................................................................................................................

12 At the prompt, enter init 4 to start the Navis™ Optical PM - MRP
application.

Result:

The application starts.

............................................................................................................................................................

13 Optionally enter top to display the status of the start process. To exit
this display, simultaneously press Ctrl and c.

Section I: Back up the database
Perform a cold backup
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Section II: Recover the database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to recover from a system failure.

Types of recoveries Two types of recoveries are available:

• hot backup recovery

• cold backup recovery

If you are recovering the system using a hot backup, you must use the
procedure for a hot backup recovery. If you are recovering using a
cold backup, you must use the procedure for a cold backup recovery.

Contents
Perform a hot backup recovery 8-8

Perform a cold backup recovery 8-10
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Perform a hot backup recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a hot backup recovery.

Before you begin Navis™ Optical PM - MRP must be shut down to perform this
procedure.

Be sure that you have the hot backup tape labeled with the following
information:

• the correct date

• server name

Task Complete the steps below to perform a hot backup recovery.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 Stop Navis™ Optical PM - MRP.

Reference:

For instructions, see in “Stop the Navis™ Optical PM - MRP
server application” (4-6) in Chapter 4, “System administration”.

............................................................................................................................................................

3 Insert the hot backup tape in the tape drive.

............................................................................................................................................................

4 When the lights on the tape drive stop flashing, enter su - dacscan

............................................................................................................................................................

5 At the prompt, enter /bin/ksh /usr/dacscan/bin/hot_recover

Result:

The hot backup recovery begins and takes approximately 90
minutes to complete. The # prompt is displayed on the system
console once the hot backup recovery is complete.

............................................................................................................................................................

6 Remove the tape, label it with the current date, and store it in a safe
place.

Section II: Recover the database System maintenance
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Result:

The hot backup recovery is complete.

............................................................................................................................................................

7 Restart the Navis™ Optical PM - MRP application by entering init 4.

Result:

The Navis™ Optical PM - MRP application starts.

Section II: Recover the database
Perform a hot backup recovery
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Perform a cold backup recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a cold backup recovery.

Before you begin Navis™ Optical PM - MRP must be shut down to perform this
procedure.

Be sure that you have the cold backup tape labeled with the
following:

• the correct date

• server name

Task Complete the steps below to perform cold backup recovery.
............................................................................................................................................................

1 Using the system console, log into the server as root.

............................................................................................................................................................

2 Stop Navis™ Optical PM - MRP.

Reference:

For instructions, see “Stop the Navis™ Optical PM - MRP server
application” (4-6) in Chapter 4, “System administration”.

............................................................................................................................................................

3 Insert a tape with a valid cold backup in the tape drive.

............................................................................................................................................................

4 When the lights on the tape drive stop flashing, enter su - dacscan

............................................................................................................................................................

5 At the prompt, enter /bin/ksh /usr/dacscan/bin/cold_recover

Result:

A prompt requests the date of the backup tape.

............................................................................................................................................................

6 Enter YYYYMMDD (or YYMMDD for older tapes).

Important! The date entered must match the date on the backup
tape.

Section II: Recover the database System maintenance
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Result:

The cold backup recovery begins. This takes approximately 90
minutes to complete. The # prompt is displayed on the system
console when the backup is complete.

............................................................................................................................................................

7 Remove the tape, label it with the current date, and store it in a safe
place.

Result:

The cold backup recovery is complete.

............................................................................................................................................................

8 At the prompt, enter init 4 to start the Navis™ Optical PM - MRP
application.

Result:

The application starts.

Section II: Recover the database
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Section III: Monitor space

Overview
....................................................................................................................................................................................................................................

Purpose Navis™ Optical PM - MRP has an internal script that periodically
checks its own file systems to verify that they are not running out of
space. This section describes Navis™ Optical PM - MRP’s space
monitoring and recovery program, Spacewatch.

Contents
Monitor space 8-13
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Monitor space
....................................................................................................................................................................................................................................

Definition: Spacewatch
program

Spacewatch is a space monitoring and recovery program that provides
hourly file system monitoring for the following controller files:

• Provisioning documents directory (/dacscan/prov)

• Alarms directory (/dacscan/alarms)

• Application logs directory (/dacscan/log)

• Database archives directory (/dacscan/dbarch)

• Application users directory (/dacscan/users)

• Application trace information directory (/dacscan/trace)

Spacewatch Parameters The Spacewatch script is executed as per parameters defined in the
root cron file. It is recommended that these parameters are not
changed.

Warning messages If a controller file is over 60% full, Spacewatch provides a warning
message to the system event log in the form of
LOG_FILESYSTEM_SPACE_LOW.

Recovery messages Specific recovery actions are provided for the /dacscan/trace,
dacscan/log, dacscan/dbarch, and dacscan/users files, if their
percentage full is over 80%.

The recovery message for the dacscan/dbarch controller file is:

″Logfile″ removed database archive file - back up database

immediately!

The recovery message for the dacscan/trace and dacscan/log files
is:

Removed log files - Archives may be incomplete!

The recovery message for the dacscan/users file is:

″Logfile″ is running low on space, clean up immediately!

Contact Lucent Customer Support for assistance with these recovery
messages.

Section III: Monitor space System maintenance
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9 Trouble clearing

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes how to turn on trace and view trace files. It
also provides tasks for viewing the core and log files.

Navis™ Optical PM - MRP
trace files

The home directory of Navis™ Optical PM - MRP is /usr/dacscan.
The application servers reside in the bin directory of the home
directory. Each server has trace information linked to it and trace can
be turned on and off via the tinfo file in /usr/dacscan/bin.

A trace file contains information that identifies equipment status at a
given point in time. The typical use of a trace file is to send it to
Lucent Technical Support to be used in remote troubleshooting
activities.

Important! The trace files should never be removed while the
application is up.

Contents
Trace Capture Guidelines Task 9-3

Enable trace on a server 9-4

Enable southbound/northbound interface tracing 9-6

Enable trace on a Windows PC 9-8

Create a single file for trace data 9-10
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View the log files 9-11

View the log file on an HP-UX server 9-12

View the console.log file on a Windows PC 9-13

Clear trace files on a server 9-14
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Trace Capture Guidelines Task
....................................................................................................................................................................................................................................

Purpose The system administrator can turn on, capture, and send trace data to
Lucent Customer Support when troubleshooting problems. Use this
task as a guideline on when to turn on trace.

Before you begin Important! Trace should only be turned on when requested by
Lucent Customer Support.

Trace should only be turned on when requested by Lucent Customer
Support.

Before editing the file in this task, you may want to first create a
copy of the file, then delete the copy when it is no longer needed.

Task Complete these steps to determine when to turn on the trace
capture capability.
............................................................................................................................................................

1 Using one of the Enable trace tasks in this section, edit the
appropriate trace configuration file to turn on trace.

............................................................................................................................................................

2 Reinitiate the condition to be checked.

Result:

Trace output should be produced.

............................................................................................................................................................

3 Send the trace output to Lucent Customer Support.

............................................................................................................................................................

4 Edit the appropriate trace configuration file to turn off trace.

Trouble clearing
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Enable trace on a server
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn on trace on a particular server and to create
a trace file for capturing information.

Important! Trace files should never be removed.

Before you begin Before you begin this task, ensure that the application is at run level
3.

Important! Before editing the file in this task, you may want to
first create a copy of the file, then delete the copy when it is no
longer needed.

Task Complete the steps below to create a trace file.
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number is displayed.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application to run level 3.

............................................................................................................................................................

3 From the system console, log into the server as dacscan.

............................................................................................................................................................

4 At the prompt, change to the directory containing the tinfo file by
entering cd /usr/dacscan/bin.

............................................................................................................................................................

5 Open the tinfo file in edit mode by entering vi tinfo.

............................................................................................................................................................

6 In the tinfo file, locate the following line: <servername> -1 0
<servername>. 0 Y

Important! In your tinfo file, <servername> will be replaced
with the actual server name.

Trouble clearing

....................................................................................................................................................................................................................................

9 - 4 Lucent Technologies 365-309-803R1.1
Issue 1, July 2002



..........................................................................................................................................................

7 IF THEN

you want to increase
tracing from 0 to 5

enter the following:
[Esc]
:1,$s/-1 0/-1 5/
[Enter]

you want to decrease
tracing from 5 to 0

enter the following:
[Esc]
:1,$s/-1 5/-1 0/
[Enter]

............................................................................................................................................................

8 Save and exit the file.

Result:

The file is saved at the new trace level.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on. A trace file named
<process_name>.<pid>.<host_name> is generated.

Note that <process_name> represents the process, for example,
SBNOTIF represents the southbound notification process.

............................................................................................................................................................

10 Verify that the trace file
/dacscan/trace/<process_name>.<pid>.<hostname> exists.

Important! To increase the available space in the /dacscan/trace
directory, retain only the latest version of each file; use rm
ulog.<old_date> command to remove old trace files.

Enable trace on a server Trouble clearing
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Enable southbound/northbound interface tracing
....................................................................................................................................................................................................................................

Purpose Use this procedure to enable southbound/northbound interface tracing
on a particular server.

Before you begin Before you begin this task, ensure that the application is at run level
3.

Task Complete the steps below to enable southbound/northbound
interface tracing.
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number is displayed, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application up to run level 3.

............................................................................................................................................................

3 From the system console, log into the server as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan.

............................................................................................................................................................

5 Create a TMSconfig file - if one does not exist already - following
the example below, otherwise, proceed to Step 7.

EMSTRACEON SBGW200Lsrv -1 -1 -1

EMSTRACEON brokerSrv -1 -1 -1

EMSTRACEON ExtObserverSrv -1 -1 -1

EMSTRACEON STMFGWSrv -1 -1 -1

TRACELOGSIZE 1000

............................................................................................................................................................

6 Save and exit the file.

Result:

The file is saved with the new trace level.

Trouble clearing
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............................................................................................................................................................

7 At the prompt, enter init 4 to bring the Navis™ Optical PM - MRP
application up to run level 4.

Result:

Southbound/northbound interface tracing is enabled.

............................................................................................................................................................

8 At the prompt, enter cat TMSconfig to verify that the trace file
exists.

Result:

The file is displayed.

Enable southbound/northbound interface
tracing
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Enable trace on a Windows PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn on trace and create a file for capturing
information on a Windows PC.

Before you begin

Before you begin this task, start the Navis™ Optical PM - MRP
application. See “Start Navis™ Optical PM - MRP user interface on a
Windows workstation (PC)” (4-10) for details.

Important! Trace files should never be removed. Before editing
the file in this task, you may want to first create a copy of the
file, then delete the copy when it is no longer needed.

Task Complete the steps below to enable trace on a Windows PC.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

..........................................................................................................................................................

2 IF THEN

you want to increase global
tracing and turn on
F-interface tracing on an
HP-UX console,

edit the /usr/add-on/ui/jui/bin/run_jnm
file by searching for gt and setting it
to gt=4 fint.tr=4

you want to increase global
tracing and turn on
F-interface tracing on a
PC,

edit the <drive>:\jui\bin\run_jnm.bat
file by searching for gt and setting it
to 5.

............................................................................................................................................................

3 Save the edited run_jnm or run_jnm.bat file.

............................................................................................................................................................

4 Shut down and restart the Navis™ Optical PM - MRP application.

See “Stop the Navis™ Optical PM - MRP server application” (4-6) and
“Start the Navis™ Optical PM - MRP server application” (4-4) in
Chapter 4, “System administration”.

Result:

Trace is turned on and a trace file is generated.

Trouble clearing
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............................................................................................................................................................

5 Verify that the trace file exists.

Enable trace on a Windows PC Trouble clearing
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Create a single file for trace data
....................................................................................................................................................................................................................................

Purpose Use this task to create one file containing information from one or
more trace files produced on the server.

Task Complete the steps below to copy trace source into one file.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /dacscan/trace.

............................................................................................................................................................

3 At the prompt, enter tar cvf trace.tar ./*

Result:

The trace files will be copied into a single file.

Trouble clearing
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View the log files
....................................................................................................................................................................................................................................

Overview All significant events associated with database backups and transfers
are logged in the log files. These events are also recorded in log files
in /dacscan/tmp.

Operator transaction logs are stored in compressed format in the
/dacscan/log/data directory with the following naming convention:

<log-prefix>.<Julian-date>.<hour>.<minute>

The following is a list of log files:

• sys (System Event) - This file records all system error messages.
The file name is tms.log.<hostname>.

• Server log file - This file logs process event and error
information. This file is stored in /dacscan/log/data/tms.log.

• PC client log file - This file is stored in
<drive>:\jui\logs\<user>.log.

Log file retention One log file is retained for each day of the week. All log files are
maintained up to seven days; the oldest file is overwritten first.

Trouble clearing
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View the log file on an HP-UX server
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the log file residing on an HP server.

Task Complete the steps below to view the log file.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

............................................................................................................................................................

2 Change to the directory containing the log file to be viewed by
entering cd /dacscan/log/data/nms.log.<server-hostname>

............................................................................................................................................................

3 Enter pg <logfilename>.log

Result:

The log file is displayed.

Trouble clearing
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View the console.log file on a Windows PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the console.log file residing on a PC.

Task Complete the steps below to view the log file.
............................................................................................................................................................

1 Log into the PC as sa.

............................................................................................................................................................

2 Using Notepad or Wordpad, display the console.log file which
resides in <drive>:\jui\logs\<user>.log.

Result:

The file is displayed.

Trouble clearing
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Clear trace files on a server
....................................................................................................................................................................................................................................

Purpose Use this task to clear trace files on a server.

Ensure that you are in the correct directory before clearing the trace
file; not all deleted files can be recovered.

Task Complete the steps below to clear trace files on a server.
............................................................................................................................................................

1 From the system console, log into the server as dacscan.

............................................................................................................................................................

2 Change to the directory containing the trace files by entering cd
/dacscan/trace

Ensure that you are in the correct directory before clearing the trace
file; not all deleted files can be recovered.

............................................................................................................................................................

3 At the prompt, enter the following:

$for i in ′ls′

do

> $i

done

Result:

The trace file’s contents is cleared.

Trouble clearing
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10 Navis™ Optical PM - MRP
Software Release, Version, and
Patch Information

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains information on how to display Navis™ Optical
PM - MRP software release, load ID, version number, and patch
information.

Contents
Display the Software Release and Load ID 10-2

Display the Software Version Number 10-3

Determine which Software Patch is Loaded 10-4
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Display the Software Release and Load ID
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the Navis™ Optical PM - MRP
release number and load ID.

Task Complete these steps to display the Navis™ Optical PM - MRP
release number and load ID:
............................................................................................................................................................

1 Log into the server as root or dacscan.

............................................................................................................................................................

2 To display the release number, enter cat /etc/dscan/release.

Result:

The current release number is displayed.

............................................................................................................................................................

3 To display the load ID, enter cat /etc/dscan/ws-tmshr-loadid.

Result:

The current load ID is displayed.

Navis ™ Optical PM - MRP Software Release, Version,
and Patch Information
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Display the Software Version Number
....................................................................................................................................................................................................................................

Purpose Use this procedure to display the version number of Navis™ Optical
PM - MRP software.

Task Complete the following steps to display the current version
number of Navis™ Optical PM - MRP.
............................................................................................................................................................

1 From the Network Map, select Help > Version.

Result:

The currently installed software version number and build date
are displayed.

Navis ™ Optical PM - MRP Software Release, Version,
and Patch Information
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Determine which Software Patch is Loaded
....................................................................................................................................................................................................................................

Purpose This procedure is used to determine which software patch is loaded.

Task Complete these steps to determine which software patch is
loaded:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type swlist | grep PATCH.

Result:

A complete patch list displays.

Navis ™ Optical PM - MRP Software Release, Version,
and Patch Information
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Appendix A: Navis™ Optical PM -
MRP File systems

Navis™ Optical PM - MRP file systems
....................................................................................................................................................................................................................................

Introduction This appendix contains a list of the Navis™ Optical PM - MRP file
systems.

List of file systems The following are the 17 file systems supported by Navis™ Optical
PM - MRP:

1. Root directory (/)

2. OS kernel (/stand)

3. Spool directories (/var)

4. Core OS components (/usr)

5. Optional OS components (/opt)

6. Provisioning documents directory (/dacscan/prov)

7. Alarms directory (/dacscan/alarms). Note that this directory
applies to host alerts; Fault Management is not supported on
Navis™ Optical PM - MRP.

8. Three Oracle tablespace directories (/oradb, /oradb2, /oradb3)

9. Application logs directory (/dacscan/log)

10. Database re-do logs and archives directory (/dacscan/dbarch
and /dacscan/journal)

11. Application users directory (/dacscan/users)

12. Application trace information directory (/dacscan/trace)

....................................................................................................................................................................................................................................
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13. Temporary directory (/tmp)

14. Application temporary space (/dacscan/tmp)

15. Application software (/usr/dacscan)

16. Application software patch history (/patch)

17. Q-adapter (/ITM-QA).

Navis™ Optical PM - MRP file systems Navis ™ Optical PM - MRP File systems
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Appendix B: Navis™ Optical PM -
MRP Off-Line tools

Overview
....................................................................................................................................................................................................................................

Purpose This appendix contains information about off-line tools available for
Navis™ Optical PM - MRP.

Tasks using the following tools are provided:

• Add a DMS Tool

• Database Population Tool

• Change a Network Element Tool

All DMSs should have been added and their databases populated
during installation. These tasks are provided for your information
only.

Contents
Section I: Add a DMS B-3

Add a DMS to the Network Map with the Add
DMS Tool

B-4

Section II: Populate the Navis™ Optical PM -
MRP database

B-6

Populate the Navis™ Optical PM - MRP Database
with Navis™ Optical NMS data

B-7

Section III: Change Network Element Tool B-9
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Change the Target Identifier (TID) on a Craft
Interface Terminal (CIT)

B-11

Change Network Element Names in ITM-SC and
Navis™ Optical PM - MRP

B-14

Change Network Element Names in Navis™ Optical
EMS and Navis™ Optical PM - MRP

B-20

Overview Navis ™ Optical PM - MRP Off-Line tools
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Section I: Add a DMS

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add or delete a Domain Management
System (DMS) using the Add a DMS Tool. Note that the term
controller in this section refers to domain map.

Contents
Add a DMS to the Network Map with the Add
DMS Tool

B-4
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Add a DMS to the Network Map with the Add DMS Tool
....................................................................................................................................................................................................................................

Purpose Use this task to add a DMS to the Navis™ Optical PM - MRP
Network Map. The task adds Navis™ Optical NMS controllers to the
controller map and then populates the Navis™ Optical PM - MRP
Network Map with areas representing the domains of the added
controllers.

Important! This task must be run for each DMS to be added.
Up to 24 DMSs may be added.

Before you begin This task requires access to:

• Navis™ Optical NMS software with ITM-SC, WaveStar Optical
EMS, and associated network elements

• Navis™ Optical PM - MRP

Also, you need the following information before you begin:

• the name for the DMS

• the DMS IP address

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete the steps below to add a DMS to the Navis™ Optical
PM - MRP Network Map.
............................................................................................................................................................

1 Log into the DMS host.

............................................................................................................................................................

2 At the prompt, enter who -r and verify that the host is at run level 4.

............................................................................................................................................................

3 From the system console, log into the Navis™ Optical PM - MRP host
as root.

............................................................................................................................................................

4 If the application is running, enter init 3.

............................................................................................................................................................

5 At the prompt, enter /usr/dacscan/bin/add.DMS

Section I: Add a DMS Navis ™ Optical PM - MRP Off-Line tools
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Result:

A prompt is displayed.

............................................................................................................................................................

6 At the prompt, enter the DMS name.

Important! Enter the DMS name in upper case. Since it will be
displayed on the GUI, create a meaningful name.

Result:

A prompt is displayed.

............................................................................................................................................................

7 Enter an acronym for the DMS.

Result:

A prompt is displayed.

............................................................................................................................................................

8 Enter the IP address of the DMS.

Result:

A successful add message is displayed.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring up the application.

............................................................................................................................................................

10 Open the Navis™ Optical PM - MRP Network Map.

............................................................................................................................................................

11 Open the Navis™ Optical PM - MRP Controller Map.

............................................................................................................................................................

12 Verify that the Navis™ Optical PM - MRP Controller Map displays the
name of the new DMS, which is preceded by DMS_.

............................................................................................................................................................

13 Start communication from the Navis™ Optical PM - MRP Controller
Map.

Result:

The new DMS should be able to establish communication with
Navis™ Optical PM - MRP, and the DMS icon on the Navis™

Optical PM - MRP Controller Map should be green.

Section I: Add a DMS
Add a DMS to the Network Map with the
Add DMS Tool
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Section II: Populate the Navis™ Optical PM - MRP database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the Navis™ Optical NMS to Navis™ Optical PM
- MRP Data Population tool. This tool is used to populate the Navis™

Optical PM - MRP Database when a Domain Management System
(DMS) is brought under the Navis™ Optical PM - MRP layer.

About this tool The Navis™ Optical NMS to Navis™ Optical PM - MRP Data
Population tool contains two parts:

• Data Collection Tool (DCT)

• Data Load Tool (DLT)

Data Collection Tool The Data Collection part of this tool exports data from the Navis™

Optical NMS layer, places it into standard ASCII format, and then
transmits the data from Navis™ Optical NMS to Navis™ Optical PM -
MRP via ftp. This tool retrieves each DMS-managed network
element’s optical links, optical multiplexed sections, optical channel
trails, digital links (including unprotected digital links), and both
protected and unprotected paths and path segments.

When the DCT is run, it automatically creates a directory to store
data.

Data Load Tool The Data Load part of this tool imports data from the Navis™ Optical
NMS layer into Navis™ Optical PM - MRP and enables users to load
either a single entity or multiple types of entities at one time. The
DLT produces an audit data file and stores the data separately from
the collected output file. The audit file contains a log of successfully
loaded data and error records.

Contents
Populate the Navis™ Optical PM - MRP Database
with Navis™ Optical NMS data

B-7
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Populate the Navis™ Optical PM - MRP Database with Navis™

Optical NMS data
....................................................................................................................................................................................................................................

Purpose This section describes how to use the Navis™ Optical PM - MRP Data
Population tool.

Before you begin Before running the Navis™ Optical PM - MRP Data Population tool,
ensure the following:

• The state of the Navis™ Optical PM - MRP and DMS should be
idle. No provisioning operations should be performed while the
Data Collection Tool is running..

• There must be sufficient space and appropriate settings for the
tool to run without encountering storage problems.

• Process information for one DMS at a time.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete the following steps to run the Navis™ Optical NMS to
Navis™ Optical PM - MRP Data Population tool.
............................................................................................................................................................

1 Log into the Navis™ Optical NMS server as dacscan.

............................................................................................................................................................

2 Enter the following commands to run the DCT tool:

cd /usr/dacscan/toolbin/offline

net_entity.ksh -n <net_entity> -e [-h]

where:

-n <net_entity> represents the required network entity to be
processed.

This value can be any of the following:

• managed_ne

• optical_link

• optical_trail

• digital_link

• path

Section II: Populate the Navis™ Optical PM
- MRP database
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-e is used to export the network entity from NMS to a file

-h prints the command usage message

Result:

The DCT exports data from the Navis™ Optical NMS layer and
places it into standard ASCII format. Then data is transmitted
manually via ftp from Navis™ Optical NMS to Navis™ Optical
PM - MRP. Results are stored in a directory created by the DCT.

............................................................................................................................................................

3 Log into the Navis™ Optical PM - MRP server as dacscan.

............................................................................................................................................................

4 Enter the following commands to run the DLT tool:

cd /usr/dacscan/toolbin/offline

net_entity.ksh -n <net_entity> -i [-vabh] [-f input_file]

where:

-n net_entity represents the required network entity to be processed.
For example,
managed_ne|optical_link|optical_trail|digital_link|path. -f input_file
represents the file from which the entities to be imported are read.
The file is assumed to be in /tmp/net_entity unless the full path is
specified. If no file is specified, the user is prompted to confirm a list
of files to process. The files must adhere to the following naming
convention: /tmp/net_entity/*net_entity.action.current.

Result:

The DLT imports data from the Navis™ Optical NMS layer into
the Navis™ Optical PM - MRP. The tool produces an audit data
file and stores it separately from the collected output file. The
audit file contains a log of successfully loaded data and error
records.

Section II: Populate the Navis™ Optical PM
- MRP database
Populate the Navis™ Optical PM - MRP
Database with Navis™ Optical NMS data
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Section III: Change Network Element Tool

Overview
....................................................................................................................................................................................................................................

Purpose When a name change occurs to an existing network element ID, the
change must be reflected in each application through which it is
managed.

This section describes how to change the identification of an existing
network element using the Change Network Element ID tool.

Change Network Element
ID Script

Network Element IDs are changed in applications as a result of
running a change network element ID script. This script is first run at
the EMS-level to support name changes to ITM-SC or Navis™ Optical
EMS controlled network elements. After the script completes, a
change script is run at the Navis™ Optical NMS-level to support
network element name changes in the Navis™ Optical NMS
application. The final step is to run the script at the Navis™ Optical
PM - MRP-level.

There are different change network element ID scripts used in the
ITM-SC, Navis™ Optical EMS, Navis™ Optical NMS, and Navis™

Optical PM - MRP applications. The tasks included in this section
capture how the ITM-SC, Navis™ Optical EMS, and Navis™ Optical
PM - MRPscripts are run.

Impact to other
applications

When Navis™ Optical NMS network elements are managed by Navis™

Optical PM - MRP, then the final step is to run the tool in the Navis™

Optical PM - MRP application.

Source File The first step of this process is to create a source file containing the
requested changes. This source file can be used by each script to
change ITM-SC or Navis™ Optical EMS controlled network element
names.

Navis ™ Optical PM - MRP Off-Line tools
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Limitations Users should mind the following limitations when renaming an
existing network element.

• The system does not perform any alphabetic ordering after the
network element name change.

• Subnet ID, Aggregate ID, and Controller Name changes are not
supported.

• The system will not update any Kanji-related tables. This
limitation is only relevant for Japanese customers.

• For the changed name to be displayed, the user must restart the
user interface.

• If a network element is deleted, has its name changed, or its
Office identification does not have an associated TID name, it
will remain on the Location Reference Table.

Contents
Change the Target Identifier (TID) on a Craft
Interface Terminal (CIT)

B-11

Change Network Element Names in ITM-SC and
Navis™ Optical PM - MRP

B-14

Change Network Element Names in Navis™ Optical
EMS and Navis™ Optical PM - MRP

B-20

Section III: Change Network Element Tool
Overview
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Change the Target Identifier (TID) on a Craft Interface Terminal
(CIT)
....................................................................................................................................................................................................................................

Purpose This task describes how to change a network element’s TID on a
network element’s CIT.

Before you begin changing the name of an existing network element, consider the
following:

• The user must ensure the uniqueness of the new network element
name.

• Changing a network element’s name should be first done in the
EMS that controls the network element. It is recommended that
users perform an EMS on-line archive before changing the
network element’s name.

• When renaming a network element, users must abide by a strict
naming convention. Note that the new network element name
should not include a backslash character because it may not be
supported.

Task Perform the following steps to change the identification of an
existing network element on a CIT.
............................................................................................................................................................

1 Log into the network element’s CIT.

............................................................................................................................................................

2 Right click on NE > Graphical (OSI) > <network_element_name>,
and then click OK.

Result:

The System Type Selection dialog box displays.

............................................................................................................................................................

3 Select a network element from the list.

Result:

The NE Login Dialog box displays.

............................................................................................................................................................

4 Enter the login and password, then click OK.

Section III: Change Network Element Tool Navis ™ Optical PM - MRP Off-Line tools
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Result:

A process dialog box displays followed by a legal notice.

............................................................................................................................................................

5 Click OK.

Result:

A form displays.

............................................................................................................................................................

6 Select Administration > Set TID, then click OK.

Result:

A form displays.

............................................................................................................................................................

7 Select Fault > Enter/Exit Maintenance Condition > Enter
Maintenance Condition, then click yes.

Result:

A red, maintenance box displays displays at the lower right area
of the form.

............................................................................................................................................................

8 Select Administration > Set TID, click OK and then change the TID.

Important! Note that the new network element name should not
include a backslash character because it may not be supported.

Result:

A form displays.

............................................................................................................................................................

9 Select Fault > Enter/Exit Maintenance Condition > Exit
Maintenance Condition, then click Exit.

Result:

The WaveStar® CIT Confirmation dialog box displays.

............................................................................................................................................................

10 Click Yes.

Result:

The TID name change process is initiated.

Section III: Change Network Element Tool
Change the Target Identifier (TID) on a
Craft Interface Terminal (CIT)
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It is important to wait for the change to be processed (about 25
minutes) before proceeding to the next step.

............................................................................................................................................................

11 To verify the change, log into the network element’s CIT, enter the
password, then click OK. See Step 1 through Step 4 for details.

............................................................................................................................................................

12 In the toolbar, click the Update button.

Result:

The new TID displays.

Section III: Change Network Element Tool
Change the Target Identifier (TID) on a
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Change Network Element Names in ITM-SC and Navis™

Optical PM - MRP
....................................................................................................................................................................................................................................

Purpose This task describes how to change existing network element identifiers
on the ITM-SC using the change network element identifier tool.

Processing Order This tool’s change script is first run on an ITM-SC host server and
then a script is run on theNavis™ Optical PM - MRP host server. This
task contains the commands to run the script on both servers.

Before you begin Before changing the name of an existing network element, consider
the following items:

• Be sure that the name change has been made. See “Change the
Target Identifier (TID) on a Craft Interface Terminal (CIT)”
(B-11) for details.

• Shut down the ITM-SC before running the off-line script. The
user will not be able to communicate with the ITM-SC at this
time.

• Navis™ Optical PM - MRP will only update the new name in the
Circuit IDs that are in M.1400 format. For Circuit IDs with
FREE FORMAT, it is the user’s responsibility to update the
Circuit IDs (using the Graphical Layout Parameters form).

• The Navis™ Optical PM - MRP will not dynamically update any
current screen with the new network element ID name. From the
Network Map, the user must select File > Query Again to
display the new name.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Important! Because the ITM-SC portion of this script may
change, please refer to the ITM-SC user documentation for
updated information on how to run this script on the ITM-SC
system.

Perform the following steps to change the identification of an
existing network element. The steps used in the first part of this

Section III: Change Network Element Tool Navis ™ Optical PM - MRP Off-Line tools
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task apply to the ITM-SC host server while the remaining steps
apply to the Navis™ Optical PM - MRP host server.
............................................................................................................................................................

1 From the Network Controller Map, right click the ITM-SC, Navis™

Optical NMS, and Navis™ Optical PM - MRP icons then select
Session > Stop Communication.

Result:

Communication is disabled on ITM-SC, Navis™ Optical NMS,
and Navis™ Optical PM - MRP.

............................................................................................................................................................

2 Log into the ITM-SC host as i2kadmin and enter the password.

Result:

The user is logged into the ITM-SC host.

............................................................................................................................................................

3 At the prompt, type . itmsc_setup

Result:

The ITM-SC set up begins.

............................................................................................................................................................

4 At the prompt, enter cd /opt/itm/sc/<latest_load_number>/ems/
bin.

Result:

The prompt resides at the specified directory.

............................................................................................................................................................

5 At the prompt, enter ls -ld .

Result:

The directory permissions display.

............................................................................................................................................................

6 View the display to verify whether or not the /bin directory is set to
744, i.e., drwxr-–r-–.

............................................................................................................................................................

7 If the /bin directory’s permissions are set to 744, go to the next step.

Section III: Change Network Element Tool
Change Network Element Names in ITM-SC
and Navis™ Optical PM - MRP
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If the /bin directory’s permissions are not set to 744, enter the
following:

chmod 744 /opt/itm/sc/<latest_load_number>/ems/bin

Important! You can optionally type chmod 744 *.

............................................................................................................................................................

8 Use a text editor to create a node_mapping file that contains the old
and new network element names.

Important! Be sure that the node_mapping file contains one
line each, in old_name|new_name format separated with a tab or
a | character. A carriage return must separate each line.

............................................................................................................................................................

9 Use ftp to copy the created node_mapping file to the Navis™ Optical
PM - MRP host server.

............................................................................................................................................................

10 At the prompt, enter ./ems_stop.

Result:

The ITM-SC is stopped.

............................................................................................................................................................

11 At the prompt, enter ./ems_db_gnrt -n

This command checks existing network elements in the ITM-SC
database.

............................................................................................................................................................

12 At the prompt, enter ./ems_db_gnrt -D <network_element_value>
-N node_mapping

Result:

The tool is initiated.

............................................................................................................................................................

13 At the prompt, enter y to confirm the actions.

Result:

The renaming tool is executed and runs until the tool has
successfully completed the renaming on the ITM-SC server. The
renaming process may now begin on the Navis™ Optical PM -
MRP server.

Section III: Change Network Element Tool
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............................................................................................................................................................

14 While the ITM-SC is still down, log into the Navis™ Optical PM -
MRP host as dacscan.

............................................................................................................................................................

15 At the prompt, enter cd /usr/dacscan/toolbin

Result:

The prompt resides at the directory where the change_neid tool
is located.

............................................................................................................................................................

16 Retrieve the ITM-SC node_mapping data file then type mv
node_mapping mrp_sc_node.

Result:

The file is renamed to mrp_sc_node.

Note that the last line of the mrp_sc_node file must not contain a
carriage return. (See Step 8.)

mrp_sc_node is only a recommended filename. Any filename can be
used.

............................................................................................................................................................

17 At the prompt, enter

./change_neid nm.node

............................................................................................................................................................

18 At the prompt, enter N.

Result:

The renaming tool is executed and runs until the tool has
successfully completed the renaming on the Navis™ Optical PM
- MRP server.

............................................................................................................................................................

19 Upon completion, log into the ITM-SC server as i2kadmin and enter
the password.

Result:

The user is logged into the ITM-SC host.

Section III: Change Network Element Tool
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............................................................................................................................................................

20 To start the ITM-SC application, at the prompt, type:

. itmsc_setup

ems_start

Result:

The ITM-SC application is restarted.

..........................................................................................................................................................

21 IF THEN

The renamed network
element is a Navis™

Optical NMS DACS 4/4/1,

Use the following steps to change the
network element name on the network
element through Navis™ Optical NMS
VCIT.

1. Login to theNavis™ Optical NMS
DACS 4/4/1 network element via
VCIT.

2. Select Provision > SystemID.

3. At the SystemID field, enter the
new network element name.

4. In the FrameID field, enter a value,
for example, 0.

5. Select the Change button. The
network element name has been
changed.

6. Perform a MIB-Upload to ITM-SC
for the renamed Navis™ Optical
NMS DACS network elements.

The renamed network
element is not a Navis™

Optical NMS DACS 4/4/1,

Perform a MIB download for all
changed network elements.
It is normal for this download to take
a long period of time to complete.

............................................................................................................................................................

22 If the rename script has run on all affected systems, then enter the
following:

From the Network Controller Map, right click the ITM-SC, Navis™

Optical NMS, and Navis™ Optical PM - MRP icons then select
Session > Start Communication.

Section III: Change Network Element Tool
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Result:

Communication is enabled on ITM-SC, Navis™ Optical NMS,
and Navis™ Optical PM - MRP.

............................................................................................................................................................

23 Restart the Navis™ Optical PM - MRP GUI and synchronize its
database with the ITM-SC server.

Section III: Change Network Element Tool
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Change Network Element Names in Navis™ Optical EMS and
Navis™ Optical PM - MRP
....................................................................................................................................................................................................................................

Purpose This task describes how to change existing network element identifiers
on the Navis™ Optical EMS using the change network element
identifier tool.

Processing Order This tool’s change script is first run on the Navis™ Optical EMS host
server and then a script is run on theNavis™ Optical PM - MRP host
server. This task contains the commands to run the script on both
servers.

Before you begin Before changing the name of an existing network element, consider
the following items:

• Be sure that the name change has been made. See “Change the
Target Identifier (TID) on a Craft Interface Terminal (CIT)”
(B-11) for details.

• Shut down the Navis™ Optical EMS before running the off-line
script. The Navis™ Optical PM - MRP user will not be able to
communicate with the Navis™ Optical EMS at this time.

• Navis™ Optical PM - MRP will only update the new name in the
Circuit IDs that are in M.1400 format. For Circuit IDs with
FREE FORMAT, it is the user’s responsibility to update the
Circuit IDs (using the Graphical Layout Parameters form).

• The Navis™ Optical PM - MRP will not dynamically update any
current screen with the new network element ID name. From the
Network Map, the user must select File > Query Again to
display the new name.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Important! Because the Navis™ Optical EMS portion of this
script may change, please refer to the Navis™ Optical EMS user
documentation for updated information on how to run this script
on the Navis™ Optical EMS system.

Perform the following steps to change the identification of an
existing network element. The steps used in the first part of this
task apply to the Navis™ Optical EMS host server while the

Section III: Change Network Element Tool Navis ™ Optical PM - MRP Off-Line tools
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remaining steps apply to the Navis™ Optical PM - MRP host
server.

............................................................................................................................................................

1 From the Network Controller Map, right click the ITM-SC, Navis™

Optical NMS, and Navis™ Optical PM - MRP icons then select
Session > Stop Communication.

Result:

Communication is disabled on ITM-SC, Navis™ Optical NMS,
and Navis™ Optical PM - MRP.

............................................................................................................................................................

2 Log into theNavis™ Optical EMS host as ems and enter the password.

Result:

The user is logged into the Navis™ Optical EMS host.

............................................................................................................................................................

3 Use a text editor to create a file that contains the old and new
network element names.

Important! Be sure that the file contains one line each, in
old_name|new_name format separated with a tab or a | character.
A carriage return must separate each line.

............................................................................................................................................................

4 Use ftp to copy the created file to the Navis™ Optical PM - MRP host
server.

............................................................................................................................................................

5 At the prompt, enter tidchange -f <created_filename> -du-y

Result:

Navis™ Optical EMS is stopped and the renaming tool runs on
the Navis™ Optical EMS host server. Upon completion, Navis™

Optical EMS is brought back up

The renaming process may now begin on the Navis™ Optical
PM - MRP server.

............................................................................................................................................................

6 While the Navis™ Optical PM - MRP server is still down, log into the
Navis™ Optical PM - MRP host as dacscan.

Section III: Change Network Element Tool
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............................................................................................................................................................

7 At the prompt, enter cd /usr/dacscan/toolbin

Result:

The prompt resides at the directory where the change_neid tool
is located.

............................................................................................................................................................

8 Retrieve the Navis™ Optical EMS node_mapping data file then type
mv node_mapping mrp_snms_node.

Result:

The file is renamed to mrp_snms_node.

Note that the last line of the mrp_snms_node file must not contain a
carriage return. (See Step 3.)

mrp_snms_node is only a recommended filename. Any filename can
be used.

............................................................................................................................................................

9 At the prompt, enter

./change_neid mrp_snms_node

............................................................................................................................................................

10 If a prompt displays, enter Y to change the circuit name or N to retain
the existing circuit name.

Important! A prompt only displays when
CKTFMT=AZTYPEID:FREE.

Result:

The renaming tool runs, completes its name change process,
then theNavis™ Optical PM - MRP host server comes back up.
The process takes about 45 minutes.

............................................................................................................................................................

11 If the rename script has run on all affected systems, then enter the
following:

From the Network Controller Map, right click the ITM-SC, Navis™

Optical NMS, and Navis™ Optical PM - MRP icons then select
Session > Start Communication.

Section III: Change Network Element Tool
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Result:

Communication is enabled on ITM-SC, Navis™ Optical NMS,
and Navis™ Optical PM - MRP.

............................................................................................................................................................

12 Restart the Navis™ Optical PM - MRP GUI and synchronize its
database with the Navis™ Optical EMS server.

Section III: Change Network Element Tool
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Appendix C: Common Unix®
Commands

Overview
....................................................................................................................................................................................................................................

Purpose This section describes a few UNIX® commands used in the
administration process. Some of these commands are used in this
document’s tasks, while others may be used when there is a need to
access remote systems or to verify network communication status.

Contents
init command for changing run levels C-2

who command for verifying system run level C-3

ping command for verifying communication C-4

telnet command for initiating remote sessions C-5

uname command for displaying system information C-6

lanscan command for verifying LAN status C-7

vgdisplay command for verifying mirroring status C-8

shutdown Command for Halting or Rebooting
Servers

C-9

ps Command for Information About Active
Processes

C-10

....................................................................................................................................................................................................................................
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init command for changing run levels
....................................................................................................................................................................................................................................

Introduction An init command is used to change the run level of the Navis™

Optical PM - MRP application on an HP-UX machine. The following
describes two run levels, run level 3 and run level 4.

Run level 3 When the system administrator enters the init 3 command, the system
switches to run level 3, which shuts down the Navis™ Optical PM -
MRP application.

Run level 4 When the system administrator enters the init 4 command, the system
to switches to run level 4, which starts up the Navis™ Optical PM -
MRP application.

Common Unix® Commands
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who command for verifying system run level
....................................................................................................................................................................................................................................

Purpose The who command allows you to verify the system run level.

Task Use this task to determine the current run level of the system.
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 At the prompt, enter who -r

Result:

A message displays a line of current run level information, such
as run-level 3 Dec 30 11:26 3 0 S.

Common Unix® Commands
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ping command for verifying communication
....................................................................................................................................................................................................................................

Description The ping command is used to determine whether it is possible to
communicate with a remote system. Failure to communicate may
result if the remote system is switched off or the communication link
is not working correctly.

When a user enters ping <host_name> —n 10 at a prompt, output
similar to the following is displayed:

PING <host_name>.lucent.com: 64 byte packets

64 bytes from <ip_address>: icmp_seq=0. time=155. ms

64 bytes from <ip_address>: icmp_seq=1. time=155. ms

64 bytes from <ip_address>: icmp_seq=2. time=155. ms

64 bytes from <ip_address>: icmp_seq=3. time=154. ms

64 bytes from <ip_address>: icmp_seq=4. time=155. ms

64 bytes from <ip_address>: icmp_seq=5. time=154. ms

64 bytes from <ip_address>: icmp_seq=6. time=154. ms

64 bytes from <ip_address>: icmp_seq=7. time=155. ms

64 bytes from <ip_address>: icmp_seq=8. time=155. ms

64 bytes from <ip_address>: icmp_seq=9. time=157. ms

----<host_name> PING Statistics----

10 packets transmitted, 10 packets received, 0% packet

loss round-trip (ms) min/avg/max = 154/154/157

To turn off ping, press the Ctrl and c keys.

Common Unix® Commands

....................................................................................................................................................................................................................................

C - 4 Lucent Technologies 365-309-803R1.1
Issue 1, July 2002



telnet command for initiating remote sessions
....................................................................................................................................................................................................................................

Description The telnet command is used to initiate a session on a remote
system. When telnet <system_name> is entered at a prompt, the
system requests the user to type the login ID and password. Once
successfully logged in, the session is active until the user logs off of
the remote system.

Common Unix® Commands
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uname command for displaying system information
....................................................................................................................................................................................................................................

Purpose The uname command allows you to identify the system with which a
terminal is communicating.

Task Use this task to display system information.
............................................................................................................................................................

1 Log into a terminal as root.

............................................................................................................................................................

2 At the prompt, enter uname —a

Result:

A line similar to the following displays:

HP-UX <host_name> B.11.00 A 9000/810 2013485357

two-user license.

Common Unix® Commands
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lanscan command for verifying LAN status
....................................................................................................................................................................................................................................

Purpose The lanscan command allows you to view the status of any of the
LANs that are connected to the server, including the LAN that
connects Navis™ Optical PM - MRP to the Domain Management
System (DMS).

Task Complete the steps below to view LAN status information.
............................................................................................................................................................

1 From the system console, log into the host as root.

............................................................................................................................................................

2 Enter lanscan

Result:

The LAN status information is displayed.

Common Unix® Commands
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vgdisplay command for verifying mirroring status
....................................................................................................................................................................................................................................

Purpose The vgdisplay command verifies that the application and databases
residing on separate disks are synchronized.

About the mirrored disk
configuration

A mirrored disk configuration eliminates the need for a second
processor as a backup. The application and database that reside on
separate disks are mirrored onto a second set of disks. Information
that is written to disk is reflected simultaneously onto the mirrored
counterpart. It is recommended that mirroring status is checked
regularly to ensure that all mirrored information is synchronized with
the primary information.

Before you begin Ensure that the LVSTATUS is set to SYNC.

Task Complete the steps below to obtain mirroring status.
............................................................................................................................................................

1 From the system console, log into the server as root.

............................................................................................................................................................

2 At the # prompt, enter vgdisplay -v | pg.

Result:

The mirroring status is displayed.

Common Unix® Commands
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shutdown Command for Halting or Rebooting Servers
....................................................................................................................................................................................................................................

Purpose The shutdown command is used to halt or reboot the servers.

Before you begin The format for the shutdown command is the following:

shutdown -<hy/ry> <seconds>

where: shutdown is the command verb used to halt or reboot the
servers.

-hy specifies that the servers are to be shut down using the halt
option.

-ry specifies that the servers are to be shut down using the reboot
option.

<seconds> specifies the numbers of seconds that are to elapse before
the shutdown commences.

Task Complete these steps to halt or reboot a server:
............................................................................................................................................................

1 Log in to the server as root.

............................................................................................................................................................

2 To shut down the server using the halt option, at the prompt type
shutdown -hy 0.

To shut down the server using the reboot option, at the prompt type
shutdown -ry 0.

Result:

The server is shut down.

Common Unix® Commands

....................................................................................................................................................................................................................................

365-309-803R1.1
Issue 1, July 2002

Lucent Technologies C - 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



ps Command for Information About Active Processes
....................................................................................................................................................................................................................................

Purpose The ps command is used to view information about active processes.

Before you begin A helpful note—by piping the output of the ps command to the wc
(word count) command, for example: ps -ef | wc, the system
displays line, word, and byte counts. The output displays numbers
such as 33 17 12, which would represent the line, word, and byte
counts of the process.

Task Complete these steps to use the ps command:
............................................................................................................................................................

1 Log in to the host server as root.

............................................................................................................................................................

2 At the system prompt, type: ps.

Result:

The system outputs information about the active processes.

Common Unix® Commands
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